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iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about Microsoft PowerPoint 2016 and then build your skills as you 
learn to perform increasingly specialized procedures. Or, if you prefer, you can jump 
in wherever you need ready guidance for performing tasks. The how-to steps are 
delivered crisply and concisely—just the facts. You’ll also find informative, full-color 
graphics that support the instructional content.

Who this book is for
Microsoft PowerPoint 2016 Step by Step is designed for use as a learning and reference 
resource by home and business users of Microsoft Office programs who want to use 
PowerPoint to create and present slide presentations and printed materials. The content 
of the book is designed to be useful for people who have previously used earlier ver-
sions of PowerPoint and for people who are discovering PowerPoint for the first time.

The Step by Step approach
The book’s coverage is divided into parts representing general PowerPoint skill sets. 
Each part is divided into chapters representing skill set areas, and each chapter is 
divided into topics that group related skills. Each topic includes expository informa-
tion followed by generic procedures. At the end of the chapter, you’ll find a series of 
practice tasks you can complete on your own by using the skills taught in the chap-
ter. You can use the practice files that are available from this book’s website to work 
through the practice tasks, or you can use your own files.
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Download the practice files
Before you can complete the practice tasks in this book, you need to download 
the book’s practice files to your computer from http://aka.ms/powerpoint2016sbs 
/downloads. Follow the instructions on the webpage.

IMPORTANT PowerPoint 2016 is not available from the book’s website. You should 
install that app before working through the procedures and practice tasks in this book.

You can open the files that are supplied for the practice tasks and save the finished 
versions of each file. If you later want to repeat practice tasks, you can download the 
original practice files again.

SEE ALSO For information about opening and saving files, see “Open and navigate 
presentations” in Chapter 2, “Create and manage presentations.”

The following table lists the practice files for this book.

Chapter Folder File

Part 1: Get started with PowerPoint 2016

1: PowerPoint 2016 basics Ch01 None

2: Create and manage presentations Ch02 NavigateSlides.pptx

3: Create and manage slides Ch03 AddRemoveSlides.pptx

ApplyThemes.pptx

ChangeBackgrounds.pptx

CreateSections.pptx

ImportOutline.docx

RearrangeSlides.pptx

ReuseSlides.pptx

xii
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Chapter Folder File

Part 2: Insert and manage slide text

4: Enter and edit text on slides Ch04 ApplyTextEffects.pptx

CheckSpelling.pptx

EditText.pptx

EnterText.pptx

FormatText.pptx

5: Present text in tables Ch05 FormatTables.pptx

InsertTables.pptx

LinkTables.pptx

ModifyTables.pptx

NewEquipment.xlsx

Part 3: Insert and manage visual elements

6: Insert and manage simple graphics Ch06 Chickens.jpg

DrawShapes.pptx

EditPictures.pptx

Fish.jpg

Flamingos.jpg

Flowers.jpg

InsertPictures.pptx

InsertScreens.pptx

Penguins01.jpg, Penguins02.jpg

Tiger01.jpg, Tiger02.jpg

YellowBird.jpg

xiii
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Chapter Folder File

7: Create and manage business graphics Ch07 CreateCharts.pptx

CreateDiagrams.pptx

Flowers01.jpg – Flowers03.jpg

FormatCharts.pptx

FormatDiagrams.pptx

ModifyCharts.pptx

ModifyDiagrams.pptx

Temperatures.xlsx

8: Add sound and movement to slides Ch08 AddAudio.pptx

AddTransitions.pptx

AddVideo.pptx

AnimateSlides.pptx

Butterfly.wmv

CustomizeAnimations.pptx

SoundTrack.wma

Wildlife.wmv

Part 4: Finalize presentations

9: Review presentations Ch09 AddNotes.pptx

ConfigureSlides.pptx

InspectPresentations.pptx

PrintSlides.pptx

YinYang.png

10: Prepare and deliver presentations Ch10 AdaptPresentations.pptx

ApplyTimings.pptx

DeliverPresentations.pptx

xiv
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Chapter Folder File

Part 5: Use advanced PowerPoint functions

11: Work in PowerPoint more efficiently Ch11 None

12: Create custom presentation 
elements

Ch12 Background.jpg

CreateThemes.pptx

CustomizeMasters.pptx

SaveTemplates.pptx

13: Save and share presentations Ch13 AddComments.pptx

RestrictAccess.pptx

SaveSlides.pptx

ShareSlides.pptx

Ebook edition
If you're reading the ebook edition of this book, you can do the following:

 ■ Search the full text
 ■ Print
 ■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/powerpoint2016sbs/detail.

Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. If you discover an error, please submit it to us at http://aka.ms/powerpoint2016sbs 
/errata.

If you need to contact the Microsoft Press Support team, please send an email message 
to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

xv
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com/MicrosoftPress.

xvi
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1PowerPoint 
2016 basics

In this chapter
 ■ Start PowerPoint

 ■ Work in the PowerPoint user 
interface

 ■ Manage Office and app settings

Practice files
No practice files are necessary to 
complete the practice tasks in this 
chapter.

You can use PowerPoint 2016 to develop professional 
presentations for electronic delivery as on-screen slide 
shows, or for print delivery as slide decks with handouts 
and note pages. You can also use PowerPoint to quite 
easily lay out complex single-page presentations for 
production as flyers, posters, or postcards, or for delivery 
as electronic files, such as pictures.

PowerPoint presentations can be an effective way of 
providing information in small segments. Individual slides 
can include bullet points, pictures, charts, tables, and 
business diagrams. Professionally designed themes visu-
ally enhance your message and provide a professional, 
coordinated appearance.

The elements that control the appearance of PowerPoint 
and the way you interact with it while you create presen-
tations are collectively referred to as the user interface. 
Some user interface elements, such as the color scheme, 
are cosmetic. Others, such as toolbars, menus, and but-
tons, are functional. The default PowerPoint configuration 
and functionality is based on the way that most people 
work with the app. You can modify cosmetic and func-
tional user interface elements to suit your preferences and 
working style.

This chapter guides you through procedures related to 
starting PowerPoint, working in the PowerPoint user 
interface, and managing Office and app settings.
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Start PowerPoint
The way that you start PowerPoint 2016 is dependent on the operating system you’re 
running on your computer. For example:

 ■ In Windows 10, you can start PowerPoint from the Start menu, the All Apps 
menu, the Start screen, or the taskbar search box.

 ■ In Windows 8, you can start PowerPoint from the Apps screen or Start screen 
search results.

 ■ In Windows 7, you can start PowerPoint from the Start menu, All Programs 
menu, or Start menu search results.

You might also have a shortcut to PowerPoint on your desktop or on the Windows 
taskbar.

When you start PowerPoint without opening a specific presentation, the PowerPoint 
Start screen appears. The Start screen is a hybrid of the Open and New pages of the 
Backstage view. It displays links to recent files in the left pane, and new file templates 
in the right pane.

TIP You can turn off the appearance of the Start screen if you want to go directly to a 
new, blank presentation. For information, see “Change default PowerPoint options” in 

Chapter 11, “Work in PowerPoint more efficiently.”

To start PowerPoint by opening a presentation

1. Do either of the following:

 ● In File Explorer, double-click the presentation.

TIP File Explorer is the current version of the browsing utility that was 
formerly known as Windows Explorer. If you’re working on a Windows 7 

computer, use Windows Explorer whenever this book refers to File Explorer. 

 ● In Microsoft Outlook, double-click a presentation that is attached to an 
email message.

TIP By default, PowerPoint opens presentations from online sources in 
protected mode.

Chapter 1: PowerPoint 2016 basics
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1
To start PowerPoint on a Windows 10 computer

1. Click the Start button, and then click All apps.

2. In the app list, click any index letter to display the alphabet index, and then click 
P to scroll the app list to the apps starting with that letter.

3. Scroll the list if necessary, and then click PowerPoint 2016 to start the app.

To start PowerPoint on a Windows 8 computer

1. From the Start screen, display the Apps screen.

2. Sort the Apps screen by name, and then click any index letter to display the 
alphabet index.

3. In the alphabet index, click P to scroll the app list to the apps starting with that 
letter. Then click PowerPoint 2016 to start the app.

Work in the PowerPoint user interface
The PowerPoint user interface provides intuitive access to all the tools you need to 
develop a sophisticated presentation tailored to the needs of your audience. You can 
use PowerPoint 2016 to do the following (and much more):

 ■ Create, import, format, and edit slide content, including text, pictures, tables, 
charts, shapes, symbols, equations, SmartArt business diagrams, audio record-
ings, and video recordings.

 ■ Capture screenshots, screen recordings, and audio recordings.

 ■ Organize and manage slides in sections.

 ■ Animate slide content and the transitions between slides; managing the form, 
timing, and sound associated with animations.

 ■ Document speaker notes for each slide.

 ■ Control the layout of content by creating custom masters; precisely align slide 
elements by using gridlines and Smart Guides.

 ■ Create, rehearse, present, and record custom slide shows.

 ■ Save, export, and send presentations in a wide variety of formats.

 ■ Create notes in a OneNote notebook that link to specific slide content.

Work in the PowerPoint user interface
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When you’re working with a presentation, it is displayed in an app window that con-
tains all the tools you need to add and format content.

A presentation displayed in the app window

About Office
PowerPoint 2016 is part of the Microsoft Office 2016 suite of apps, which also 
includes Microsoft Access, Excel, Outlook, and Word. The apps in the Office 
suite are designed to work together to provide highly efficient methods of 
getting things done. You can install one or more Office apps on your com-
puter. Some apps have multiple versions designed for different platforms. For 
example, you can install different versions of PowerPoint on a computer, a 
smartphone, an iPad, and an Android device; you can also work in a version 
of PowerPoint that is hosted entirely online. Although the core purpose of an 
app remains the same regardless of the platform on which it runs, the avail-
able functionality and the way you interact with the app might be different.

Chapter 1: PowerPoint 2016 basics
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1The app that is described and depicted in images throughout this book is a 
standard desktop installation of PowerPoint 2016 on a Windows 10 computer. 
It is available as part of the Office 2016 suite of apps, as a freestanding app, or 
as part of an Office 365 subscription.

Until recently, the standard way of acquiring Office software was to purchase 
a disc, packaged in a box, and install the software from the disc. In the recent 
past, the standard distribution model has changed to an online installation, 
often as part of an Office 365 subscription licensing package.

Office 365, which was originally available only to businesses, now has many 
subscription options designed for individual home and business users, 
students, households, small businesses, midsize businesses, enterprises, 
government agencies, academic institutions, and nonprofits; in other words, 
whatever your needs may be, there is an Office 365 subscription option that 
will be a close fit. Many of the Office 365 subscription options include licens-
ing for the desktop Office apps and permit users to run Office on multiple 
devices, including Windows computers, Mac computers, Windows tablets, 
Android tablets, iPads, and smartphones.

If you have an Office 365 subscription and are working on a presentation that 
is stored on a Microsoft SharePoint site or in a Microsoft OneDrive folder, 
you’ll also have access to PowerPoint Online. You can review and edit presen-
tations in PowerPoint Online, which runs directly in your browser instead of 
on your computer. Office Online apps are installed in the online environment 
in which you’re working and are not part of the desktop version that you 
install directly on your computer.

SEE ALSO For information about connecting to OneDrive and SharePoint 
sites, see “Manage Office and app settings” later in this chapter.

PowerPoint Online displays the contents of a presentation very much like the 
desktop app does, and offers a limited subset of the commands and content 
formatting options that are available in the full desktop app. If you’re work-
ing with a presentation in PowerPoint Online and find that you need more 
functionality than is available, and you have the full version of PowerPoint 
installed on your computer, you can open the presentation in the full version.

Work in the PowerPoint user interface
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Identify app window elements
The PowerPoint app window contains the elements described in this section. Com-
mands for tasks you perform often are readily available, and even those you might 
use infrequently are easy to find.

Title bar
At the top of the app window, this bar displays the name of the active file, identifies 
the app, and provides tools for managing the app window, ribbon, and content.

The title bar elements are always on the left end, in the center, and on the right end of the title bar

The Quick Access Toolbar at the left end of the title bar can be customized to include 
any commands that you want to have easily available. The default Quick Access Tool-
bar in the PowerPoint app window displays the Save, Undo, Redo/Repeat, and Start 
From Beginning buttons. On a touchscreen device, the default Quick Access Toolbar 
also includes the Touch/Mouse Mode button.

SEE ALSO For information about Touch mode, see “Work with the ribbon and status 
bar” later in this topic.

You can change the location of the Quick Access Toolbar and customize it to include 
any command to which you want to have easy access.

TIP You might find that you work more efficiently if you organize the commands you 
use frequently on the Quick Access Toolbar and then display it below the ribbon, directly 

above the workspace. For information, see “Customize the Quick Access Toolbar” in Chapter 11, 
“Work in PowerPoint more efficiently.” 

Four buttons at the right end of the title bar serve the same functions in all Office 
apps. You control the display of the ribbon by clicking commands on the Ribbon 

Chapter 1: PowerPoint 2016 basics
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Display Options menu, temporarily hide the app window by clicking the Minimize 
button, adjust the size of the window by clicking the Restore Down/Maximize button, 
and close the active presentation or exit the app by clicking the Close button.

SEE ALSO For information about different methods of closing presentations and 
exiting PowerPoint, see “Save and close presentations” in Chapter 2, “Create and 

manage presentations.”

Ribbon
The ribbon is located below the title bar. The commands you’ll use when working with 
a presentation are gathered together in this central location for efficiency.

Your ribbon might display additional tabs

TIP The available ribbon tabs and the appearance of the commands on the ribbon 
might differ from what is shown in this book, based on the apps that are installed on 

your computer, the PowerPoint settings and window size, and the screen settings. For more 
information, see the sidebar “Adapt procedure steps” later in this chapter.

Across the top of the ribbon is a set of tabs. Clicking a tab displays an associated set of 
commands arranged in groups.

Commands related to managing PowerPoint and presentations (rather than presen-
tation content) are gathered together in the Backstage view, which you display by 
clicking the File tab located at the left end of the ribbon. Commands available in the 
Backstage view are organized on named pages, which you display by clicking the 
page tabs in the colored left pane. You redisplay the presentation and the ribbon by 
clicking the Back arrow located above the page tabs.

Work in the PowerPoint user interface
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You manage files and app settings in the Backstage view

Commands related to working with presentation content are represented as buttons 
on the remaining tabs of the ribbon. The Home tab, which is active by default, con-
tains the most frequently used commands.

When a graphic element such as a picture, table, or chart is selected on a slide, one 
or more tool tabs might appear at the right end of the ribbon to make commands 
related to that specific object easily accessible. Tool tabs are available only when the 
relevant object is selected.

TIP Some older commands no longer appear as buttons on the ribbon but are still 
available in the app. You can make these commands available by adding them to the 

Quick Access Toolbar or the ribbon. For more information, see “Customize the Quick Access 
Toolbar” and “Customize the ribbon” in Chapter 11, “Work in PowerPoint more efficiently.”

On each tab, buttons representing commands are organized into named groups. You 
can point to any button to display a ScreenTip that contains the command name, a 
description of its function, and its keyboard shortcut (if it has one).

Chapter 1: PowerPoint 2016 basics
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ScreenTips can include the command name, keyboard shortcut, and description

TIP You can control the display of ScreenTips and of feature descriptions in ScreenTips. 
For more information, see “Change default PowerPoint options” in Chapter 11, “Work in 

PowerPoint more efficiently.”

Some buttons include an arrow, which might be integrated with or separate from 
the button. To determine whether a button and its arrow are integrated, point to the 
button to activate it. If both the button and its arrow are shaded, clicking the button 
displays options for refining the action of the button. If only the button or arrow 
is shaded when you point to it, clicking the button carries out its default action or 
applies the current default formatting. Clicking the arrow and then clicking an action 
carries out the action. Clicking the arrow and then clicking a formatting option applies 
the formatting and sets it as the default for the button.

Examples of buttons with separate and integrated arrows

When a formatting option has several choices available, they are often displayed in 
a gallery of images, called thumbnails, that provide a visual representation of each 
choice. When you point to a thumbnail in a gallery, the Live Preview feature shows 
you what the active content will look like if you click the thumbnail to apply the asso-
ciated formatting. When a gallery contains more thumbnails than can be shown in the 
available ribbon space, you can display more content by clicking the scroll arrow or 
More button located on the right border of the gallery.

Work in the PowerPoint user interface
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Related but less common commands are not represented as buttons in a group. 
Instead, they’re available in a dialog box or pane, which you display by clicking the 
dialog box launcher located in the lower-right corner of the group.

TIP To the right of the groups on the ribbon is the Collapse The Ribbon button, which is 
shaped like a chevron. For more information, see “Work with the ribbon and status bar,” 

later in this topic. 

Tell me what you want to do
Entering a term in the Tell Me What You Want To Do box located to the right 
of the ribbon tabs displays a list of related commands and links to additional 
resources online. Or you can press F1 to open the Help window for the cur-
rent app.

The easy path to help when working in PowerPoint

Status bar
Across the bottom of the app window, the status bar displays information about the 
current presentation and provides access to certain PowerPoint functions. You can 

Chapter 1: PowerPoint 2016 basics
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choose which statistics and tools appear on the status bar. Some items, such as Docu-
ment Updates Available, appear on the status bar only when that condition is true.

You can specify which items you want to display on the status bar

SEE ALSO For information about displaying updates when coauthoring a PowerPoint 
presentation, see “Coauthor presentations” in Chapter 13, “Save and share presentations.”

The Notes and Comments buttons, View Shortcuts toolbar, Zoom Slider tool, and 
Zoom button are at the right end of the status bar. These tools provide you with con-
venient methods for changing the display of presentation content.

You can display and hide content, display different content views, and change the magnification from the 
status bar

SEE ALSO For information about changing the content view, see “Display different 
views of presentations” in Chapter 2, “Create and manage presentations.” For informa-

tion about entering notes, see “Add notes to slides” in Chapter 9, “Review presentations.” For 
information about entering comments, see “Add and review comments” in Chapter 13, “Save 
and share presentations.” 

Work in the PowerPoint user interface
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Work with the ribbon and status bar
The goal of the ribbon is to make working with presentation content as intuitive as 
possible. The ribbon is dynamic, meaning that as its width changes, its buttons adapt 
to the available space. As a result, a button might be large or small, it might or might 
not have a label, or it might even change to an entry in a list.

For example, when sufficient horizontal space is available, the buttons on the View 
tab of the PowerPoint app window are spread out, and you can review the commands 
available in each group.

At 1024 pixels wide, most button labels are visible

If you decrease the horizontal space available to the ribbon, small button labels disap-
pear and entire groups of buttons might hide under one button that represents the 
entire group. Clicking the group button displays a list of the commands available in 
that group.

When insufficient horizontal space is available, labels disappear and groups collapse under buttons

When the ribbon becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Clicking the scroll arrow displays the hidden groups.

Scroll to display additional group buttons

Chapter 1: PowerPoint 2016 basics
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The width of the ribbon depends on these three factors:

 ■ Window width Maximizing the app window provides the most space for the 
ribbon.

 ■ Screen resolution creen resolution is the size of your screen display expressed 
as pixels wide × pixels high. The greater the screen resolution, the greater 
the amount of information that will fit on one screen. Your screen resolution 
options are dependent on the display adapter installed in your computer, 
and on your monitor. Common screen resolutions range from 800 × 600 to 
2560 × 1440 (and some are larger). The greater the number of pixels wide (the 
first number), the greater the number of buttons that can be shown on the 
ribbon.

 ■ The magnification of your screen display If you change the screen magni-
fication setting in Windows, text and user interface elements are larger and 
therefore more legible, but fewer elements fit on the screen.

You can hide the ribbon completely if you don’t need access to any of its buttons, or 
hide it so that only its tabs are visible. (This is a good way to gain vertical space when 
working on a smaller screen.) Then you can temporarily redisplay the ribbon to click a 
button, or permanently redisplay it if you need to click several buttons.

If you’re working on a touchscreen device, you can turn on Touch mode, which pro-
vides more space between buttons on the ribbon and status bar. (It doesn’t affect the 
layout of dialog boxes or panes.) The extra space is intended to lessen the possibility 
of accidentally tapping the wrong button with your finger.

Touch mode has a greater amount of space on the ribbon and status bar

The same commands are available in Touch mode, but they’re often hidden under 
group buttons.

SEE ALSO For information about working with a modified ribbon, see the sidebar 
“Adapt procedure steps” later in this topic. 

Work in the PowerPoint user interface
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You can switch between Touch mode and Mouse mode (the standard desktop app 
user interface) from the Quick Access Toolbar. Switching any one of the primary Office 
apps (Access, Excel, Outlook, PowerPoint, and Word) to Touch mode turns it on in all 
of them.

To maximize the app window

1. Do any of the following:

 ● Click the Maximize button.

 ● Double-click the title bar.

 ● Drag the borders of a non-maximized window.

 ● Drag the window to the top of the screen. (When the pointer touches the 
top of the screen, the dragged window maximizes.)

To change the screen resolution

TIP Methods of changing screen resolution vary by operating system, but you should 
be able to access the settings in Windows 10, Windows 8, and Windows 7 by using these 

methods.

1. Do any of the following:

 ● Right-click the Windows 10 desktop, and then click Display settings. At the 
bottom of the Display pane of the Settings window, click the Advanced 
display settings link.

 ● Right-click the Windows 8 or Windows 7 desktop, and then click Screen 
resolution.

 ● Enter screen resolution in Windows Search, and then click Change the 
screen resolution in the search results.

 ● Open the Display Control Panel item, and then click Adjust resolution.

2. Click or drag to select the screen resolution you want, and then click Apply or 
OK. Windows displays a preview of the selected screen resolution.

3. If you like the change, click Keep changes in the message box that appears. If 
you don’t, the screen resolution reverts to the previous setting.

Chapter 1: PowerPoint 2016 basics
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1
To completely hide the ribbon

1. Near the right end of the title bar, click the Ribbon Display Options button.

The Ribbon Display Options button is on the title bar so that it is available when the ribbon is hidden

2. On the Ribbon Display Options menu, click Auto-hide Ribbon.

TIP To redisplay the ribbon, click the Ribbon Display Options button and then click 
Show Tabs or Show Tabs And Commands.

To display only the ribbon tabs

1. Do any of the following:

 ● Double-click any active tab name.

 ● Near the upper-right corner of the app window, click the Ribbon Display 
Options button, and then click Show Tabs.

 ● In the lower-right corner of the ribbon, click the Collapse the Ribbon 
button.

 ● Press Ctrl+F1.

To temporarily redisplay the ribbon

1. Click any tab name to display the tab until you click a command or click away 
from the ribbon.

Work in the PowerPoint user interface
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To permanently redisplay the ribbon

1. Do any of the following:

 ● Double-click any tab name.

 ● Near the upper-right corner of the app window, click the Ribbon Display 
Options button, and then click Show Tabs and Commands.

 ● Press Ctrl+F1.

To optimize the ribbon for touch interaction

1. On the Quick Access Toolbar, click or tap the Touch/Mouse Mode button, and 
then click Touch.

To specify the items that appear on the status bar

1. Right-click the status bar to display the Customize Status Bar menu. A check 
mark indicates each item that is currently enabled.

2. Click to enable or disable a status bar indicator or tool. The change is effected 
immediately. The menu remains open to permit multiple selections.

3. When you finish, click away from the menu to close it.

Adapt procedure steps
This book contains many images of user interface elements (such as the rib-
bons and the app windows) that you’ll work with while performing tasks in 
PowerPoint on a Windows computer. Depending on your screen resolution 
or app window width, the PowerPoint ribbon on your screen might look dif-
ferent from that shown in this book. (If you turn on Touch mode, the ribbon 
displays significantly fewer commands than in Mouse mode.) As a result, pro-
cedural instructions that involve the ribbon might require a little adaptation.

Simple procedural instructions use this format:

1. On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

1. On the Transitions tab, in the Timing group, click the Sound arrow and 
then, in the Sound list, click Chime.

Chapter 1: PowerPoint 2016 basics
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1If differences between your display settings and ours cause a button to 
appear differently on your screen than it does in this book, you can easily 
adapt the steps to locate the command. First click the specified tab, and then 
locate the specified group. If a group has been collapsed into a group list 
or under a group button, click the list or button to display the group’s com-
mands. If you can’t immediately identify the button you want, point to likely 
candidates to display their names in ScreenTips.

Multistep procedural instructions use this format:

1. Display the presentation in Normal view.

2. Select the animated object or objects that you want to modify.

3. On the Animations tab, in the Timing group, click the Start arrow to 
display the list of start timing options.

4. In the Start list, click After Previous.

On subsequent instances of instructions that require you to follow the same 
process, the instructions might be simplified in this format because the work-
ing location has already been established:

1. In Normal view, select the animated objects that you want to modify.

2. On the Animations tab, in the Start list, click After Previous.

The instructions in this book assume that you’re interacting with on-screen 
elements on your computer by clicking (with a mouse, touchpad, or other 
hardware device). If you’re using a different method—for example, if your 
computer has a touchscreen interface and you’re tapping the screen (with 
your finger or a stylus)—substitute the applicable tapping action when you 
interact with a user interface element.

Instructions in this book refer to user interface elements that you click or tap 
on the screen as buttons, and to physical buttons that you press on a key-
board as keys, to conform to the standard terminology used in documenta-
tion for these products.

When the instructions tell you to enter information, you can do so by typing 
on a connected external keyboard, tapping an on-screen keyboard, or even 
speaking aloud, depending on your computer setup and your personal 
preferences.

Work in the PowerPoint user interface
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Manage Office and app settings
You access app settings from the Backstage view; specifically, from the Account page 
and the PowerPoint Options dialog box.

The Account page of the Backstage view in PowerPoint displays information about 
your installation of PowerPoint (and other apps in the Office suite) and the resources 
you connect to. This information includes:

 ■ Your Microsoft account and links to manage it.

 ■ The current app window background and theme.

 ■ Storage locations and services (such as Facebook and LinkedIn) that you’ve 
connected Office to.

 ■ Your subscription information and links to manage the subscription, if you have 
Office through an Office 365 subscription.

 ■ The app version number and update options.

Account information in PowerPoint

Chapter 1: PowerPoint 2016 basics
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1Microsoft account options
If you use Office 365, Skype, OneDrive, Xbox Live, Outlook.com, or a Windows 
Phone, you already have a Microsoft account. (Microsoft account credentials 
are also used by many non-Microsoft products and websites.) If you don’t 
already have a Microsoft account, you can register any existing account as a 
Microsoft account, sign up for a free Outlook.com or Hotmail.com account 
and register that as a Microsoft account, or create an alias for an Outlook.com 
account and register the alias.

TIP Many apps and websites authenticate transactions by using Microsoft 
account credentials. For that reason, it’s a good idea to register a personal 
account that you control, rather than a business account that your employer 
controls, as your Microsoft account. That way, you won’t risk losing access if 
you leave the company.

Two ways you can personalize the appearance of your PowerPoint app window are by 
choosing an Office background and an Office theme. (These are specific to Office and 
aren’t in any way associated with the Windows theme or desktop background.) The 
background is a subtle design that appears in the title bar of the app window. There 
are 14 backgrounds to choose from, or you can choose to not have a background.

Backgrounds depict a variety of subjects

Manage Office and app settings
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At the time of this writing, there are three Office themes:

 ■ Colorful Displays the title bar and ribbon tabs in the color specific to the app, 
and the ribbon commands, status bar, and Backstage view in light gray

 ■ Dark Gray Displays the title bar and ribbon tabs in dark gray, and the ribbon 
commands, status bar, and Backstage view in light gray

 ■ White Displays the title bar, ribbon tabs, and ribbon commands in white, and 
the status bar in the app-specific color

There are rumors that another theme will be released in the near future, but it hasn’t 
yet made an appearance.

TIP The images in this book depict the No Background option to avoid interfering with 
the display of any user interface elements, and the Colorful theme. 

From the Connected Services area of the page, you can connect Office to Facebook, 
Flickr, and YouTube accounts to access pictures and videos; to SharePoint sites and 
 OneDrive storage locations; and to LinkedIn and Twitter accounts to share presenta-
tions. You must already have an account with one of these services to connect Office 
to it.

Until you connect to storage locations, they aren’t available to you from within 
Power Point. For example, when inserting a picture onto a slide, you will have the 
option to insert a locally stored picture or to search online for a picture. After you 
connect to your Facebook, SharePoint, and OneDrive accounts, you can also insert 
pictures stored in those locations.

The changes that you make on the Account page apply to all the Office apps installed 
on all the computers associated with your account. For example, changing the Office 
background in PowerPoint on one computer also changes it in Outlook on any other 
computer on which you’ve associated Office with the same account.

Some of the settings on the Account page are also available in the PowerPoint 
Options dialog box, which you open from the Backstage view. This dialog box also 
contains hundreds of options for controlling the way PowerPoint works. Chapter 11, 
“Work in PowerPoint more efficiently,” provides in-depth coverage of these options. 
It’s a good idea to familiarize yourself with the dialog box content so you know what 
you can modify. 

Chapter 1: PowerPoint 2016 basics
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To display your Office account settings

1. With PowerPoint running, click the File tab to display the Backstage view.

2. In the left pane of the Backstage view, click Account.

To manage your Microsoft account settings

1. Display the Account page of the Backstage view.

2. In the User Information area, click any of the links to begin the selected 
process.

To change the app window background for all Office apps

1. Display the Account page of the Backstage view.

2. In the Office Background list, point to any background to display a live preview 
in the app window, and then click the background you want.

To change the app window color scheme for all Office apps

1. Display the Account page of the Backstage view.

2. In the Office Theme list, click Colorful, Dark Gray, or White.

To connect to a cloud storage location or social media service

1. Display the Account page of the Backstage view.

2. At the bottom of the Connected Services area, click Add a service, click the 
type of service you want to add, and then click the specific service.

You can connect to OneDrive and OneDrive for Business sites by clicking the OneDrive link

Manage Office and app settings
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To manage your Office 365 subscription

1. Display the Account page of the Backstage view.

2. In the Product Information area, click the Manage Account button to display 
the sign-in page for your Office 365 management interface.

3. Provide your account credentials and sign in to access your options.

To manage Office updates

1. Display the Account page of the Backstage view.

2. Click the Update Options button, and then click the action you want to take.

You can install available updates from the Backstage view before the automatic installation occurs

To open the PowerPoint Options dialog box

1. In the left pane of the Backstage view, click Options.

Skills review
In this chapter, you learned how to:

 ■ Start PowerPoint

 ■ Work in the PowerPoint user interface

 ■ Manage Office and app settings

Chapter 1: PowerPoint 2016 basics
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Practice tasks
No practice files are necessary to complete the practice tasks in this 
chapter.

Start PowerPoint
Perform the following tasks:

1. Using the technique that is appropriate for your operating system, start 
PowerPoint.

2. When the Start screen appears, press the Esc key to create a new blank 
presentation.

Work in the PowerPoint user interface
Start PowerPoint, create a new blank presentation, maximize the app window, and 
then perform the following tasks:

1. On each tab of the ribbon, do the following:

 ● Review the available groups and commands.

 ● Display the ScreenTip of any command you’re not familiar with. Notice the 
different levels of detail in the ScreenTips.

 ● If a group has a dialog box launcher in its lower-right corner, click the dialog 
box launcher to display the associated dialog box or pane.

2. Change the width of the app window and notice the effect it has on the ribbon. 
When the window is narrow, locate a group button and click it to display the 
commands.

3. Maximize the app window. Hide the ribbon entirely, and notice the change in 
the app window. Redisplay the ribbon tabs (but not the commands). Temporarily 
display the ribbon commands, and then click away from the ribbon to close it.

4. Use any of the procedures described in this chapter to permanently redisplay 
the ribbon tabs and commands.

5. Display the status bar shortcut menu, and identify the tools and statistics that 
are currently displayed on the status bar. Add any indicators to the status bar 
that will be useful to you.

6. Keep the presentation open in PowerPoint for use in the next set of practice 
tasks.
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Manage Office and app settings
With a new blank presentation open in PowerPoint, perform the following tasks:

1. Display the Account page of the Backstage view and review the information 
that is available there.

2. Expand the Office Background list. Point to each background to display a live 
preview of it. Then click the background you want to apply.

3. Apply each of the Office themes, and consider its merits. Then apply the theme 
you like best.

TIP If you apply a theme other than Colorful, your interface colors will be 
different from the interface shown in the screenshots in this book, but the 

functionality will be the same. 

4. Review the services that Office is currently connected to. Expand the Add a ser-
vice menu and point to each of the menu items to display the available services. 
Connect to any of these that you want to use.

5. Click the Update Options button and note whether updates are currently avail-
able to install.

TIP The update process takes about 10 minutes, and requires that you exit all 
the Office apps and Internet Explorer. If updates are available, apply them after 

you finish the practice tasks in this chapter. 

6. On the Update Options menu, click View Updates to display the What’s New 
and Improved in Office 2016 webpage in your default browser. Review the infor-
mation on this page to learn about any new features that interest you.

7. Return to PowerPoint and open the PowerPoint Options dialog box.

8. Explore each page of the dialog box. Notice the sections and the settings in 
each section. Note the settings that apply only to the current file.

9. Review the settings on the General page, and modify them as necessary to fit 
the way you work. Then close the dialog box.

10. Close the presentation without saving changes.
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2Create and 
manage 
presentations

In this chapter
 ■ Create presentations

 ■ Open and navigate 
presentations

 ■ Display different views of 
presentations

 ■ Display and edit presentation 
properties

 ■ Save and close presentations

PowerPoint makes it easy to efficiently create effective 
presentations for a wide variety of audiences. PowerPoint 
presentations are no longer used solely by business execu-
tives to present information at board meetings. They’re 
commonly used in business and educational settings to 
share information, not only in group presentations, but 
also in electronic communications and online settings. 
Even primary school students are assigned PowerPoint 
presentations as homework projects. Whether you need 
to give a report about a research study, present a budget 
to a board of directors, or convince management to invest 
in a new piece of equipment, PowerPoint helps you get 
the job done in a professional, visually appealing way. 

The sophisticated presentation features of PowerPoint are 
easy to find and use, so even novice users can work pro-
ductively with PowerPoint after only a brief introduction. 
Many of the processes you perform with slide content 
are similar to processes you use in Microsoft Word docu-
ments and Microsoft Excel workbooks, so if you already 
use another Microsoft Office app, you might be familiar 
with them. Processes that are specific to the creation and 
management of slides are unique to PowerPoint.

This chapter guides you through procedures related to 
creating presentations, opening and navigating presen-
tations, displaying different views of presentations, dis-
playing and editing presentation properties, and saving 
and closing presentations.

Practice files
For this chapter, use the practice files 
from the PowerPoint2016SBS\Ch02 
folder. For practice file download 
instructions, see the introduction.
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Create presentations
When creating a new presentation, you can start by using a blank presentation or 
by using a presentation that is based on a template. Unlike the templates provided 
for Word and Excel, most PowerPoint templates are design templates that control 
thematic elements (colors, fonts, and graphic effects) and slide layouts rather than 
content templates that provide purpose-specific placeholder content. Each tem-
plate has a corresponding theme, so you can create a presentation based on one 
template but then entirely change its appearance by applying a different theme.

When you start PowerPoint, the app displays a Start screen that gives you options for 
opening an existing presentation or creating a new one.

The Start screen appears by default but can be disabled

IMPORTANT The templates that appear by default in your installation of PowerPoint 
might be different from those shown in images in this book. The templates can change 

depending on your use of PowerPoint and the installation of program updates. 
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There are a few different ways to start a new presentation. If you press the Esc key 
when this screen appears, PowerPoint starts a blank presentation for you. You can 
also select from among the presentation thumbnails and links to create presentations 
based on the following sources:

 ■ Blank presentation If you want to build and format a presentation from 
scratch, you can start with a presentation based on the Blank Presentation tem-
plate. A new, blank presentation contains only a blank title page; it’s up to you 
to add slides and slide content, apply a theme, and make any necessary custom 
configuration changes. Creating attractive, functional presentations from 
scratch can be time-consuming and requires quite a bit of knowledge about 
PowerPoint. You’ll learn the skills you need while you work through this book.

SEE ALSO For information about themes, see “Apply themes” in Chapter 3, 
“Create and manage slides.” 

 ■ Design template You can save time by basing your presentation on one of 
the many design templates that come with PowerPoint. A design template is 
a blank presentation with a theme already applied to it. Sometimes it includes 
background graphic elements and specialized slide layouts. Some templates 
supply only a title slide and leave it to you to add the other slides you need; 
other templates supply an example of each of the available slide layouts.

 ■ Content template You can preview and download many prepopulated 
presentation templates from the Office website. These templates provide not 
only the design elements but also suggestions for content that is appropriate 
for different types of presentations, such as reports or product launches. After 
you download a template, you simply customize the content provided in the 
template to meet your needs.

An important thing to be aware of when you create a presentation in PowerPoint 
is that you have the choice of two slide aspect ratios, which are referred to (slightly 
 inaccurately) as slide sizes. The default slide size is Widescreen (16:9), which is opti-
mized for displays such as those found on many laptop screens and desktop monitors 
these days.
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Widescreen slides are shorter than Standard slides

The alternative slide size is Standard (4:3), which is optimized for wide rectangular 
screens such as that of the iPad.

Standard slides fit tablet screens
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The actual size (dimensions) of the slide aren’t as important as its aspect ratio. By 
default, the slides in presentations you create based on the Blank Presentation tem-
plate are set to Widescreen size. 

SEE ALSO For more information about slide sizes, see “Configure slides for presenta-
tion or printing” in Chapter 9, “Review presentations.”

When you display the built-in templates on the New page of the Backstage view, the 
default slide size of each template is apparent from its thumbnail. Most of the tem-
plates are 16:9, but you can easily filter the templates to display only those that are 
formatted specifically for 4:3 slides.

Before you begin adding content to a new presentation, you should consider how the 
presentation will be viewed and choose the most appropriate slide size. It’s advisable 
to select the slide size before you select the presentation template. You can change 
the slide size after you create the slide deck, but doing so might cause graphic ele-
ments (especially those on master slides) to look different, and text and other slide 
elements to not fit on slides as intended.

Whether you create a blank presentation or a presentation that is based on a design 
template, the presentation exists only in your computer’s memory until you save it.

SEE ALSO For information about saving presentations, see “Save and close presenta-
tions” later in this chapter.

To create a new blank presentation

1. Start PowerPoint.

2. When the Start screen appears, press the Esc key.

Or

1. If PowerPoint is already running, click the File tab to display the Backstage view.

2. In the left pane of the Backstage view, click New to display the New page.

3. On the New page of the Backstage view, click the Blank Presentation 
thumbnail.
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To preview presentation design templates

1. Display the Backstage view, and then, in the left pane, click New.

2. On the New page, scroll the pane to view the presentation design templates 
that were installed with PowerPoint.

3. Click any thumbnail to open a preview window that displays the title slide of the 
selected design with alternative color schemes and graphic backgrounds.

Each design template has multiple color variants and slide layouts

4. Do any of the following:

 ● Click the More Images arrows to display other slide layouts for the 
template.

 ● Click any of the thumbnails in the right half of the preview window to apply 
that color scheme to the slide layouts of the selected template.

 ● Click the arrows to the left and right of the preview window to preview 
other design templates.

 ● Click the Create button to create a presentation based on the template that 
is active in the preview window.

 ● In the upper-right corner of the preview window, click the Close button to 
close the preview window without creating a presentation.

To display only presentation templates that are optimized at the 4:3 slide size

1. On the New page of the Backstage view, below the Search box, click 4:3.
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Common filters are available below the Search box

To create a presentation based on a default design template

1. Display the New page of the Backstage view.

2. Scroll the pane to locate the design you want to use.

3. Do either of the following:

 ● Double-click the thumbnail to create the presentation.

 ● Click the thumbnail to preview the design template, and then click the 
Create button in the preview window to create the presentation.

PowerPoint displays the new presentation in Normal view. The title slide is 
 visible in the Thumbnails pane and in the Slide pane.

The title slide of a new presentation
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TIP The Notes pane is below the Slide pane but is collapsed by default. For information 
about working in the Notes pane, see “Add notes to slides” in Chapter 9, “Review 

presentations.”

To create a presentation based on an online template

1. Display the New page of the Backstage view.

2. In the search box at the top of the page, enter a term related to the template 
content or design you’re looking for, and then click the Search button.

Or

Below the search box, click one of the suggested searches.

You can enter a color as a search term to display templates that feature that color

3. In the Category list, click any category or categories to further filter the 
templates.
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Clicking multiple categories applies multiple filters

TIP PowerPoint displays applied category filters in colored bars at the top of the 
Category list. To remove a filter, point to it and then click the X that appears to 

the right of the category name, or double-click the category name.

4. Scroll the pane to locate a design that fit your needs.

5. Click any thumbnail to preview the design template, and click the More Images 
arrows to see the content defined as part of the template. Then click the Create 
button in the preview window to create the presentation.

Or

Double-click any thumbnail to create a presentation based on the template.

To disable the display of the Start screen

1. In the Backstage view, click Options to open the PowerPoint Options dialog box.

2. On the General page of the dialog box, clear the Show the Start screen when 
this application starts check box.

3. Close the PowerPoint Options dialog box.
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Open and navigate presentations
The Start screen that appears by default when you start PowerPoint displays a list of 
presentations you worked on recently, and a link to open other existing presenta-
tions. If the presentation you want to open appears on the Start screen, you can open 
it directly from there. Otherwise, you open presentations from the Open page of the 
Backstage view.

The Open page includes all the locations you've linked to from an Office program

When a presentation is open, you can move among slides by clicking or tapping ele-
ments in several areas of the app window, including the Thumbnails pane in Normal 
view and the Slide pane in Normal view or Slide Sorter view. You can also move 
among slides by rotating the wheel button on a mouse.
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The scroll bar indicates the position of the current slide in the presentation

To open a recent presentation

1. Start PowerPoint.

2. On the Start screen, in the Recent list, click the file name of the presentation 
you want to open.

Or

1. With PowerPoint running, click the File tab to display the Backstage view.

2. In the left pane of the Backstage view, click Open to display the Open page.

3. In the right pane of the Open page, scroll the presentation list if necessary to 
locate the presentation you want to open, and then click the presentation file 
name to open it.

To open any existing presentation

1. Start PowerPoint.

2. On the Start screen, at the bottom of the left pane, click Open Other 
 Presentations to display the Open page of the Backstage view.

Or
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With PowerPoint running, display the Backstage view, and then click Open 
to display the Open page.

The Places list includes all the locations you've linked to from an Office program

3. In the Places list, click the local or network storage location where the presen-
tation is stored.

4. Navigate to the presentation storage folder by using one of the following 
methods:

 ● In the right pane, click a recent folder. Then click any subfolders until you 
reach the folder you want.

 ● In the left pane, click Browse to open the Open dialog box. Then click fold-
ers in the Navigation pane, double-click folders in the file pane, or enter the 
folder location in the Address bar.

5. Double-click the presentation you want to open.
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TIP In the Open dialog box, clicking a file name and then clicking the Open arrow 
displays a list of alternative ways to open the selected file. To look through a presenta-

tion without making any inadvertent changes, you can open the file as read-only, open an 
independent copy of the file, or open it in Protected view. You can also open the file in a web 
browser. In the event of a computer crash or other similar incident, you can tell PowerPoint to 
open the file and try to repair any damage.

To move back or forward one slide while working in a presentation

1. Use any of the following techniques

 ● In the Slide pane, on the scroll bar, click above or below the scroll box.

 ● Below the Slide pane scroll bar, click the Previous Slide or Next Slide 
button.

Use the Previous Slide and Next Slide buttons or the thumbnails to move more quickly  
among slides

 ● Press the Page Up or Page Down key.

SEE ALSO For information about moving among slides in Reading view, see “Display 
different views of presentations” later in this chapter.

To move among slides while working in a presentation

1. Use any of the following techniques:

 ● In the Thumbnails pane, click the slide you want to display.

 ● In the Slide pane, drag the scroll bar up or down.
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A tooltip displays the slide that will be shown if you stop dragging

 ● Press the Home key to move to the first slide.

 ● Press the End key to move to the last slide.

TIP When you open a presentation you have worked on recently, PowerPoint displays a 
flag adjacent to the Slide pane’s scroll bar. Clicking the flag displays a link to the slide 

you were working on when you closed the presentation, with the date and time of your last 
change. Simply click the link to jump to that slide.

Display different views of presentations
The elements of a presentation that you want to have a good view of change depend-
ing on what you’re currently doing with the presentation. You can switch among 
standard presentation views, adjust the elements shown in each view, and change the 
magnification of the content in the app window.

Display standard views
PowerPoint has six views in which you can create, organize, and preview presenta-
tions. The views are:

 ■ Normal view This view includes the Thumbnails pane on the left side of the 
app window, the Slide pane on the right side of the window, and an optional 
Notes pane at the bottom of the window. You insert, cut, copy, paste, duplicate, 
and delete slides in the Thumbnails pane, create slide content in the Slide pane, 
and record slide notes in the Notes pane.
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SEE ALSO For information about working with notes, see ”Add notes to slides” 
in Chapter 9, “Review presentations.”

 ■ Notes Page view This is the only view in which you can create speaker notes 
that contain elements other than text. Although you can add speaker notes in 
the Notes pane in Normal view, you must be in Notes Page view to add graphics, 
tables, diagrams, or charts to your notes.

 ■ Outline view This view displays a text outline of the presentation in the Outline 
pane and the active slide in the Slide pane. You can enter text either directly on 
the slide or in the outline.

SEE ALSO For information about working with outlines, see ”Enter text on 
slides” in Chapter 4, “Enter and edit text on slides.”

 ■ Reading view In this view, which is ideal for previewing the presentation, 
each slide fills the screen. You can click buttons on the navigation bar to move 
through or jump to specific slides.

In Reading view, the navigation bar and View Shortcuts toolbar are at the right end of the status bar

 ■ Slide Show view This view displays the presentation as a full-screen slide 
show, beginning with the current slide. It displays only the slides and not the 
presenter tools.

 ■ Slide Sorter view This view displays thumbnails of all the slides in the presenta-
tion. In this view, you manage the slides, rather than the slide content. You can 
easily reorganize the slides, group them into sections, and apply transitions to 
one or multiple slides. You can also apply transitions from one slide to another, 
and specify how long each slide should remain on the screen.

SEE ALSO For information about changing the order of slides, see “Rearrange 
slides and sections” in Chapter 3, “Create and manage slides.” For information 

about applying transitions, see ”Add and manage slide transitions” in Chapter 8, “Add 
sound and movement to slides.”
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The views you’ll use most frequently when developing presentations are Normal view 
and Slide Sorter view.

The primary presentation development views

SEE ALSO For information about creating more elaborate notes, see ”Add notes to 
slides” in Chapter 9, “Review presentations.”

View options are available from the View Shortcuts toolbar near the right end of the 
status bar and from the View tab of the ribbon.

The active view is shaded

To review a presentation (or deliver it to an audience), you display it in Slide Show 
view. In this view, each slide fills the screen, and PowerPoint implements transitions, 
animations, and media effects the way you have specified. You can start the slide 
show from the first slide or from the currently active slide.
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TIP You can control the default look of a presentation by working with the masters 
displayed in Slide Master view, Handout Master view, or Notes Master view. For 

information about masters, see “Customize slide masters and layouts” in Chapter 12, “Create 
custom presentation elements.”

To switch among development views of a presentation

1. Do either of the following:

 ● On the View Shortcuts toolbar, click the Normal or Slide Sorter button.

TIP Clicking the Normal button while it is active switches between Normal 
and Outline views.

 ● On the View tab, in the Presentation Views group, click the Normal or 
Slide Sorter button.

To display a presentation in Slide Show view from the first slide

1. Do either of the following:

 ● On the Slide Show tab, in the Start Slide Show group, click the From 
 Beginning button. (When you point to this button, the ScreenTip that 
appears says Start From Beginning.)

 ● Press F5.

To display a presentation in Slide Show view from the current slide

1. Do any of the following:

 ● On the View Shortcuts toolbar, click the Slide Show button.

 ● On the Slide Show tab, in the Start Slide Show group, click the From 
Current Slide button. (When you point to this button, the ScreenTip that 
appears says Start from This Slide.)

 ● Press Shift+F5.

SEE ALSO For information about delivering a presentation to an audience, see “Present 
slide shows” in Chapter 10, “Prepare and deliver presentations.”

43

Display different views of presentations



To navigate a presentation in Slide Show view

1. Do any of the following:

 ● Move the mouse to display the Slide Show toolbar. Then click the Previous 
or Next button on the toolbar.

The Slide Show toolbar hides itself until you activate it

 ● Press the N (for next), Enter, Right Arrow, Down Arrow, or Page Down key 
to move forward one slide.

 ● Press the P (for previous), Backspace, Left Arrow, Up Arrow, or Page Up key 
to move back one slide.

 ● Press the Home key to display the first slide.

 ● Press the End key to display the last slide.

 ● Press the Esc key to return to Normal or Slide Sorter view.

SEE ALSO For more information about the Slide Show tools, see “Present slide shows” 
in Chapter 10, “Prepare and deliver presentations.”

To display a presentation in Reading view

1. Do either of the following:

 ● On the View Shortcuts toolbar, click the Reading View button.

 ● On the View tab, in the Presentation Views group, click the Reading View 
button.
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To navigate a presentation in Reading view

1. Do any of the following:

 ● Press the N (for next), Enter, Right Arrow, Down Arrow, or Page Down key 
to move forward one slide.

 ● Press the P (for previous), Backspace, Left Arrow, Up Arrow, or Page Up key 
to move back one slide.

 ● Press the Home key to display the first slide.

 ● Press the End key to display the last slide.

 ● Press the Esc key or click the Normal or Slide Sorter button on the View 
Shortcuts toolbar to return to Normal or Slide Sorter view.

Display program elements
You can change the space available for the app window elements by adjusting the 
relative sizes of the panes or collapsing the ribbon.

TIP Any changes you make to a view, such as adjusting the sizes of panes, are saved 
with the presentation that is open at the time and do not affect other presentations.

To adjust the size of the Thumbnails pane in Normal view

1. Do either of the following:

 ● Point to the right border of the Thumbnails pane, and drag right or left to 
resize or hide the Thumbnails pane.

 ● When the Thumbnails pane is hidden, click the Thumbnails button at the 
top of the bar to redisplay it.

TIP When you adjust the width of the Thumbnails pane, the size of the slide thumbnails 
is adjusted accordingly—that is, there are more small thumbnails in a narrow pane and 

fewer large thumbnails in a wide pane.

To show or hide the Notes pane in Normal view

1. On the status bar, click the Notes button. 
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To adjust the size of the Notes pane in Normal view

1. Point to the border between the Slide pane and the Notes pane, and when the 
pointer changes to a bar with opposing arrows, drag up or down to resize or 
hide the Notes pane.

To hide the ribbon in Normal, Outline, or Slide Sorter views

1. Do any of the following:

 ● At the right end of the ribbon, click the Collapse the Ribbon button, which 
resembles an upward-pointing arrow.

 ● Press Ctrl+F1.

Collapsing the ribbon hides the groups and buttons but leaves the tab names 
visible.

To temporarily redisplay the ribbon

1. Click any tab name.

The ribbon remains visible until you click a button on it or click away from it.

To permanently redisplay the ribbon

1. Do any of the following:

 ● Double-click any tab name.

 ● Click any tab name and then click the Pin the ribbon button, which 
 resembles a pushpin.

 ● Press Ctrl+F1.

Change the display of content
You can easily switch among multiple open presentations. If you want to compare 
or work with the content of multiple presentations, you can simplify the process by 
displaying the presentations next to each other.
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Tiling app windows simplifies the process of comparing, copying, or moving content

To help you to more precisely position and align slide elements, you can display 
rulers, gridlines, and guides in the Slide pane, and change the magnification of the 
current slide.

Use gridlines and guides to more precisely position objects
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Gridlines are faint dotted lines that mark off specific units of measure on a slide. You 
can adjust the spacing of gridlines in the Grid And Guides dialog box, but you can’t 
move them on the slide. Guides are a set of vertical and horizontal alignment tools 
that you can drag to any location in the Slide pane.

To display a different open presentation

1. Do either of the following:

 ● On the View tab, in the Window group, click the Switch Windows button, 
and then click the presentation you want to view.

 ● Point to the PowerPoint button on the Windows taskbar, and then click the 
thumbnail of the presentation you want to display.

To display multiple open presentations at the same time

1. On the View tab, in the Window group, click the Arrange All button.

To display or hide the ruler, gridlines, and guides

1. On the View tab, in the Show group, select or clear the Ruler, Gridlines, or 
Guides check boxes.

To modify the spacing of gridlines

1. On the View tab, click the Show dialog box launcher to open the Grid and 
Guides dialog box.

2. In the Grid settings area, change either the fractional or unit measurement of 
the Spacing setting. Then click OK.

To change the magnification of content in the app window

1. On the View tab, in the Zoom group, click the Zoom button to open the Zoom 
dialog box.
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You can select a magnification or enter a specific percentage

2. In the Zoom dialog box, select a Zoom to option or enter a specific percentage 
in the Percent box, and then click OK.

Or

1. In the zoom controls at the right end of the status bar, do any of the following:

 ● At the left end of the slider, click the Zoom Out button to decrease the 
zoom percentage.

 ● At the right end of the slider, click the Zoom In button to increase the zoom 
percentage.

 ● At the right end of the status bar, click the Fit slide to current window 
button.

Clicking the Fit Slide To Current Window button is a quick way to view the entire slide at the largest 
size that fits in the Slide pane
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Display and edit presentation properties
Properties are file attributes or settings, such as the file name, size, creation, date, 
author, and read-only status. Some properties exist to provide information to com-
puter operating systems and apps. You can display properties within a presentation 
(for example, you can display the slide number on a slide). PowerPoint automatically 
tracks some of the properties for you, and you can set others. 

You can examine the properties that are attached to a presentation from the Info 
page of the Backstage view. 

Some of the properties stored with a typical presentation
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You can change or remove basic properties in the default Properties pane or expand 
the Properties pane to make more available, or display the Properties dialog box to 
access even more properties.

To display presentation properties

1. Display the Info page of the Backstage view. The standard properties associ-
ated with a presentation are displayed in the Properties area of the right pane.

2. At the bottom of the Properties pane, click Show All Properties to expand 
the pane.

3. At the top of the Properties pane, click Properties and then click Advanced 
Properties to display the Properties dialog box.

To edit presentation properties

1. In the Properties pane, click the value for the property you want to edit to acti-
vate the content box. (Note that not all properties are available to edit. Those 
that can be edited will display an edit box when you point to them. Nothing 
happens if you click one that can’t be edited.)

2. Enter or replace the property value, and then press Enter.

Or

1. In the Properties dialog box, do either of the following:

 ● On the Summary page, click the box to the right of the property you want 
to modify, and then enter or replace the property value.

 ● On the Custom page, select the property you want to modify in the Name 
list, and then enter or replace the property value in the Value box.

Save and close presentations
You save a presentation the first time by clicking the Save button on the Quick Access 
Toolbar or by displaying the Backstage view and then clicking Save As. Both actions 
open the Save As page, where you can select a storage location.
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Save your presentation in an online location to access it from anywhere

TIP Many countries have laws that require that certain types of digital content be 
accessible to people with various disabilities. If your presentation must be compatible 

with assistive technologies, you need to know the final file format(s) of your presentation 
before you create it and start adding content. Some types of content are visible in a PowerPoint 
file in Normal view but not in other accessible file formats such as tagged PDFs. Before basing a 
presentation on a template you have not used before, test it for accessibility.

You can save the presentation in a folder on your computer or, if you have an Inter-
net connection, in a folder on your Microsoft OneDrive. If your company is running 
Microsoft SharePoint, you can add your SharePoint OneDrive or a different Share-
Point location so that it is available from the Places pane of the Save As page, just 
like any other folder. 

SEE ALSO For information about OneDrive, see the sidebar “Save files to OneDrive” 
later in this chapter.

Clicking Browse at the bottom of the left pane displays the Save As dialog box, in 
which you assign a name to the file.
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Use standard Windows techniques in either the Address bar or the Navigation pane to navigate to the folder 
you want

TIP If you want to create a new folder in which to store the file, click the New Folder 
button on the dialog box’s toolbar.

After you save a presentation for the first time, you can save changes simply by click-
ing the Save button on the Quick Access Toolbar. The new version of the presentation 
then overwrites the previous version.

If you want to keep both the new version and the previous version, display the Save As 
page, and then save a new version with a different name in the same location or with 
the same name in a different location. (You cannot have two files with the same name 
in the same folder.)

TIP By default, PowerPoint periodically saves the presentation you are working on. To 
adjust the time interval between saves, display the Backstage view, and click Options. In 

the left pane of the PowerPoint Options dialog box, click Save, and then specify the period of 
time in the Save AutoRecover Information Every box.
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Every time you open a presentation, a new instance of PowerPoint starts. If you have 
more than one presentation open, clicking the Close button at the right end of a 
presentation’s title bar closes that presentation and exits that instance of PowerPoint. 
If you have only one presentation open and you want to close the presentation but 
leave PowerPoint running, display the Backstage view and then click Close.

To save a presentation

1. On the Quick Access Toolbar, click the Save button to display the Save As page 
of the Backstage view.

2. Select a storage location, and then in the right pane, click Browse to open the 
Save As dialog box.

TIP The dialog box displays the contents of the folder in which you last saved or 
opened a file from within the program. If the Navigation pane and toolbar are 

not displayed, click Browse Folders in the lower-left corner of the dialog box.

3. Use standard Windows techniques to navigate to your file folder.

4. In the File name box, enter a name for your presentation, and then click Save to 
store the file in your file folder.

Or

1. Press Ctrl+S to save an existing presentation without changing the file name or 
location.

TIP Programs that run on Windows use file name extensions to identify different 
types of files. For example, the extension .pptx identifies PowerPoint 2016, 2013, 

2010, and 2007 presentations. Windows programs do not display these extensions 
by default, and you shouldn’t enter them in the File Name box. When you save a file, 
PowerPoint automatically adds whatever extension is associated with the type of file 
selected in the Save As Type box.
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To close a presentation

1. Do any of the following:

 ● At the right end of the title bar, click the Close button to close the presentation 
and the app window.

 ● Display the Backstage view, and then click Close to close the presentation 
without exiting the app.

 ● On the Windows Taskbar, point to the PowerPoint button to display 
thumbnails of all open presentations, point to the thumbnail of the presen-
tation you want to close, and then click the Close button that appears in its 
upper-right corner.

Compatibility with earlier versions
The Microsoft Office 2016 programs use file formats based on XML. By 
default,  PowerPoint 2016 files are saved in the .pptx format.

You can open a .ppt file created with an earlier version of PowerPoint in 
PowerPoint 2016, but the newer features of PowerPoint are not available. The 
presentation name appears in the title bar with [Compatibility Mode] to its 
right. You can work in this mode, or you can convert the presentation to the 
current format by clicking the Convert button on the Info page of the Back-
stage view, or by saving the presentation as a different file in the PowerPoint 
Presentation format.

If you work with people who are using a version of PowerPoint earlier than 
2007, you can save your presentations in a format that they will be able to use 
by changing the Save As Type setting in the Save As dialog box to PowerPoint 
97-2003 Presentation.
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Save files to OneDrive
Whether you’re working in a corporate environment or at home, you have 
the option of saving files to OneDrive. The OneDrive location you save to 
might be part of your company’s SharePoint environment, or it might be a 
cloud-based storage location that is associated with your Microsoft account. 
Saving a file in either type of OneDrive location provides the option of shar-
ing the file with other people.

To save a presentation to OneDrive, display the Save As page of the Back-
stage view, click your OneDrive, and then specify the OneDrive folder in 
which you want to save the file. If your OneDrive doesn’t already appear in 
the list of locations, click Add A Place, click OneDrive, and then enter the cre-
dentials associated with the OneDrive you want to access.

When you save a PowerPoint presentation to OneDrive, you and other 
people with whom you share the presentation can work on it by using a local 
installation of PowerPoint or by using PowerPoint Online, which is available in 
the OneDrive environment.

SEE ALSO For information about PowerPoint Web App, see Chapter 1, 
“PowerPoint 2016 basics.”

Microsoft provides free OneDrive storage to Microsoft account holders. If you 
already have a Microsoft account, you can access your OneDrive directly 
from any Office program, or from onedrive.live.com. If you don’t yet have a 
Microsoft account, you can configure any existing email account as a Microsoft 
account at signup.live.com. (If you don’t yet have an email account that you 
want to configure for this purpose, you can get a new account there, too.) 

OneDrive for Business is available as part of a SharePoint 2016 environment, 
and your storage there will be managed by your company or SharePoint 
provider.
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Skills review
In this chapter, you learned how to:

 ■ Create presentations

 ■ Open and navigate presentations

 ■ Display different views of presentations

 ■ Display and edit presentation properties

 ■ Save and close presentations
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Practice tasks
The practice file for these tasks is located in the PowerPoint2016SBS\Ch02 
folder. You can save the results of the tasks in the same folder.

Create presentations
Do not start PowerPoint before beginning this task.

1. Start PowerPoint and create a new, blank presentation.

2. Display the available presentation design templates.

3. Preview a template that you like.

4. Without closing the preview window, preview the next or previous template.

5. From the preview window, create a presentation based on the currently dis-
played template. Notice that the unsaved blank presentation closes.

6. Leave the presentation open and continue to the next task.

Open and navigate presentations
Complete the following tasks:

1. From the Backstage view, open the NavigateSlides presentation.

2. Navigate among the slides by using the Thumbnails pane, and then by using 
the Previous Slide and Next Slide buttons.

3. Use a keyboard method to move to the last slide of the presentation.

4. Leave the presentations open and continue to the next task.

Display different views of presentations
Complete the following tasks:

1. Display the NavigateSlides presentation in Slide Sorter view and select Slide 2.

2. Display the presentation in Slide Show view, beginning with Slide 2.

3. Move forward through the presentation to its end. Then return to Slide 
Sorter view.
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4. Display the presentation in Reading view. Use any method to navigate to the 
fourth slide, and then use the most efficient method to return to the first slide.

5. Display the presentation in Normal view. Hide the Thumbnails pane and display 
the Notes pane.

6. Redisplay the Thumbnails pane and hide the ribbon.

7. Arrange the two presentations side by side on the screen.

8. In the NavigateSlides presentation, display the gridlines. Notice that they 
appear in both open presentations.

9. In the NavigateSlides presentation, change the spacing of the gridlines to 1”. 
Notice that this modification affects only the active presentation.

10. Switch to the presentation you created in the first practice task. Display the 
guides, and then move them so they align with the upper-left corner of 
the slide content area. Notice the effect of these actions in the other open 
presentation.

11. Set the magnification of the active presentation to 60% and notice the effect of 
this action in the other open presentation.

12. Leave the presentations open and continue to the next task.

Display and edit presentation properties
Maximize the NavigateSlides window, and then complete the following tasks:

1. Display all the presentation properties.

2. Edit the Subject property, entering Colors as the subject of the presentation.

3. Leave the presentations open and continue to the next task.

Save and close presentations
Complete the following tasks:

1. Save the NavigateSlides presentation as MyPresentation, and then close it.

2. Close the presentation you created in the first task without saving it.
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3Create and 
manage slides

In this chapter
 ■ Add and remove slides

 ■ Divide presentations into 
sections

 ■ Rearrange slides and sections

 ■ Apply themes

 ■ Change slide backgrounds

When you create a presentation from a design template, 
the only slide that is immediately available is the title 
slide. It’s up to you to add more slides for the content 
that you want the presentation to include. You can create 
slides based on slide templates that are designed to hold 
specific types of content, or you can copy existing slides 
from other presentations.

When the presentation you’re developing has multiple 
slides, you can organize them into sections. Sections 
are not visible to the audience, but they make it easier 
to work with slide content in logical segments. A logical 
presentation and an overall consistent look, punctuated 
by variations that add weight exactly where it is needed, 
can enhance the likelihood that your intended audience 
will receive the message you want to convey.

This chapter guides you through procedures related 
to adding and removing slides, dividing presentations 
into sections, rearranging slides and sections, applying 
themes, and changing slide backgrounds.

TIP The content in this chapter is about slides in 
general, rather than the content of the slides. Chapters 

4 through 8 of this book are about working with the various 
types of slide content.

Practice files
For this chapter, use the practice files 
from the PowerPoint2016SBS\Ch03 
folder. For practice file download 
instructions, see the introduction.

61



Add and remove slides
The appearance and structure of slides is defined by the slide layouts associated 
with the slide master that is part of the design template. Slide layouts define the ele-
ments on specific types of slides, such as:

 ■ Slide backgrounds and incorporated graphics.

 ■ Text box locations, sizes, and formats.

 ■ Default paragraph and character formats for each text box location.

 ■ Standard headers or footers.

TIP Text boxes can contain static content that can’t be changed by the presentation 
author (for example, a company logo), or they can serve as placeholders that define the 

default formatting of content entered within the text box.

A slide master could have only one slide layout, but most have unique slide layouts 
for slides that display the presentation title, section titles, and various combinations of 
slide titles and content, and a blank slide with only the background. Each slide layout 
is named; the name suggests the primary application of the slide layout, but you 
aren’t limited to that suggestion; you can enter any type of content in any slide layout 
and modify the layout of any slide. The slide layouts that are available in a presenta-
tion are displayed on the New Slide menu.

SEE ALSO For information about working with slide masters and slide layouts, see 
“Customize slide masters and layouts” in Chapter 12, “Create custom presentation 

elements.”
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The structure and design of each slide layout is visible on its thumbnail

You can modify the built-in slide layouts, create your own slide layouts, or create 
entirely new sets of slide layouts called slide masters, and you can reset slides to 
match their slide layouts, or apply different slide layouts to existing slides.
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Insert new slides
When you create a new slide, PowerPoint inserts it after the currently active slide. In a 
new presentation based on a standard PowerPoint template, a slide you add after the 
title slide has the Title And Content layout, and a slide added after a slide other than 
the title slide has the layout of the preceding slide.

The Title And Content layout accommodates a title and either text or graphic content—a table, chart, 
 diagram, picture, clip art image, or media clip

If you want to add a slide that has a different layout, you can select the layout when 
you insert the slide or you can change the slide layout after you create the slide.

To add a slide based on the default slide layout

1. Select the slide after which you want to add the new slide.

2. Do either of the following:

 ● On the Home tab, in the Slides group, click the New Slide button 
(not its arrow).

 ● Press Ctrl+M.

TIP You can reset slide content to the slide layout defaults by clicking the Reset 
button in the Slides group on the Home tab. If you add content to a slide and 

then realize that the content would work better with a different layout, you can change 
the slide layout by clicking the Layout arrow in the Slides group, and then clicking the 
slide layout you want to apply.
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To add a slide based on any slide layout

1. Select the slide after which you want to add the new slide.

2. On the Home tab, in the Slides group, click the New Slide arrow to display the 
New Slide gallery and menu.

3. In the gallery, click a slide layout thumbnail to add a slide based on that slide layout.

Copy and import slides and content
You can reuse slides from one presentation in another, in one of two ways: you can 
copy the slides from the original presentation to the new presentation, or you can 
use the Reuse Slides tool, which displays the content of an original presentation and 
allows you to choose the slides you want to insert in the new presentation.

Within a presentation, you can duplicate an existing slide to reuse it as the basis for a 
new slide. You can then customize the duplicated slide instead of having to create it 
from scratch.

If you frequently include a certain type of slide in your presentations, such as a slide 
that introduces you to the audience, you don’t have to re-create the slide for each 
presentation. You can easily reuse a slide from one presentation in a different pres-
entation. (You can use the same techniques to reuse a slide from someone else’s 
presentation to standardize the appearance or structure of slide content with other 
members of your organization.) The slide takes on the formatting of its new presenta-
tion unless you specify otherwise.

PowerPoint automatically applies the new theme to reused slides
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If the content of your presentation exists in a document, you can configure that 
content in outline format and then import the outline into PowerPoint. For the import 
process to work smoothly, format the document content that you want to port into 
the presentation as headings. PowerPoint converts some styles into slide headings, 
converts some styles into bullet points, and ignores other styles.

A slide created from an imported outline

The following table illustrates how PowerPoint converts Word document styles to 
PowerPoint slide elements.

Word document style PowerPoint presentation style

Title, Subtitle, Heading 1, any bulleted 
list level, or any numbered list level

Slide title

Heading 2 First-level bulleted list item

Heading 3 Second-level bulleted list item

Heading 4 Third-level bulleted list item

Heading 5 Fourth-level bulleted list item

Heading 6 Fifth-level bulleted list item

Heading 7 Sixth-level bulleted list item

Heading 8 Seventh-level bulleted list item

Heading 9 Eighth-level bulleted list item
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To select a single slide

1. Do any of the following:

 ● In Normal view, click the slide in the Thumbnails pane.

 ● In Outline view, click the slide header in the Outline pane.

 ● In Slide Sorter view, click the slide in the Slide pane.

To select multiple slides

1. In Normal view, Outline view, or Slide Sorter view, click the first slide you want 
to select.

2. Do either of the following:

 ● To select a contiguous series of slides, press and hold the Shift key, and then 
click the last slide you want to select.

 ● To select noncontiguous slides, press and hold the Ctrl key, and then click 
each additional slide you want to select.

To insert a copy of a slide immediately following the original slide

1. Display the presentation in Normal view.

2. In the Thumbnails pane, right-click the slide that you want to copy, and then 
click Duplicate Slide.

To insert a copy of one or more slides anywhere in a presentation

1. Display the presentation in Normal view or Slide Sorter view.

2. Do either of the following to copy a slide or slides:

 ● Select the slide thumbnail or thumbnails, and then press Ctrl+C or, on the 
Home tab, in the Clipboard group, click the Copy button.

 ● Right-click a slide thumbnail, and then click Copy.

3. Do either of the following to insert the slide copy or copies:

 ● Click the thumbnail that you want to insert the slide copy or copies after, 
or click the empty space after the thumbnail. Then press Ctrl+V or, on the 
Home tab, in the Clipboard group, click the Paste button.
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 ● Right-click where you want to insert the slide copy or copies, and then, in 
the Paste Options section of the shortcut menu, click the Use Destination 
Theme button or the Keep Source  Formatting button.

You can match the destination theme, retain the source theme, or paste as a picture

TIP When PowerPoint displays the paste options, press H to use the 
destination style or K to use the source style.

4. Repeat step 3 to paste additional copies of the slide or slides into the 
presentation.

To insert a slide from another presentation

1. Open the source and destination presentations in PowerPoint. Display each 
presentation in Normal view or Slide Sorter view.

2. Display the two PowerPoint windows side by side.

3. In the source presentation, select the slide or slides you want to copy.

4. Drag the selection to the destination presentation. A horizontal line between 
slide thumbnails in Normal view or a vertical line between thumbnails in Slide 
Sorter view indicates the location at which PowerPoint will insert the slides.

PowerPoint creates copies of the slides and applies the destination theme to the 
copies.

Or
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1. Display the destination presentation in Normal view.

2. On the Home tab or Insert tab, in the Slides group, click the New Slide arrow.

3. On the New Slide menu, below the gallery, click Reuse Slides to open the 
Reuse Slides pane on the right side of the screen.

4. Click the Browse button, and then click Browse File. In the Browse dialog box, 
browse to the folder that contains the presentation you want to use slides from, 
and then double-click the presentation.

TIP If you’ve previously connected to the presentation you want to import slides 
from, you can click the down arrow in the Insert Slide From box to expand the 

list, and then click the presentation in the list, or click the presentation file name in the 
Open section of the Reuse Slide pane.

Or

Click the Browse button, and then click Browse Slide Library. In the Select a 
Slide Library window, browse to the slide library that contains the slide or slides 
you want to insert.

SEE ALSO For information about slide libraries, see the sidebar “SharePoint slide 
libraries” in this topic.

The Reuse Slides pane displays thumbnails of the available slides.

5. In the Reuse Slides pane, click the thumbnail of each slide you want to use to 
insert that slide into your presentation.

TIP The reused slide takes on the design of the presentation in which it is 
inserted. If you want the slide to retain the formatting from the source presenta-

tion instead, select the Keep Source Formatting check box at the bottom of the Reuse 
Slides pane.

6. Close the Reuse Slides pane.
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To prepare a source document to import as a presentation

1. Enter the content that you want to appear on the slides (and any other content) 
in a document.

2. Review the styles applied to the content you want to include in the 
presentation.

 ● Title, Subtitle, Heading 1, and any list items will convert to 
slide titles.

 ● Heading 2 through Heading 8 will convert to bulleted list 
items.

3. Save and close the document.

To create a presentation by importing a Word document

1. On the Open page of the Backstage view, click Browse.

2. In the file type list, click All Files (* .*).

3. Browse to the folder that contains the Word document that contains the slide 
title and bullet point information.

4. Double-click the document to create a new presentation.

5. Select all the slides in the new presentation, and then on the Home tab, in the 
Slides group, click the Reset button.

6. Apply the design template you want.

SEE ALSO For information about applying design templates to presentations, see 
“Create presentations” in Chapter 2, “Create and manage presentations.”

To create slides in an existing presentation by importing a Word document

1. Select the slide after which you want to insert the new slides.

2. On the Home tab or Insert tab, in the Slides group, click the New Slide arrow.

3. On the New Slide menu, below the gallery, click Slides from Outline to open 
the Insert Outline dialog box, which resembles the Open dialog box.

4. Use standard Windows techniques to browse to the folder that contains the 
Word document you want to use for the slide titles and content.

5. Double-click the document to insert slides based on its content.
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SharePoint slide libraries
If your organization uses a version of Microsoft SharePoint that supports 
slide libraries, you and your colleagues can store individual slides or entire 
presentations in a slide library so they are available for use by anyone who 
has access to the library. At the time of this writing, the current versions 
of SharePoint (SharePoint Server 2013 and SharePoint Online 2013) don’t 
support the creation of new slide libraries but you can publish slides to and 
insert slides from legacy libraries.)

To store slides in a slide library, follow these steps:

1. On the Share page of the Backstage view, click Publish Slides, and then 
click the Publish Slides button.

2. In the Publish Slides dialog box, select the check box of each slide 
you want to publish. (Click the Select All button to select the entire 
presentation.)

3. In the Publish To box, enter or paste the URL of the slide library (or click 
the Browse button and browse to the slide library).

Each slide is published individually

4. Click Publish.
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Hide and delete slides
If you create a slide and then later realize that you don’t need it, you can delete it. If 
you don’t need the slide for a presentation to a specific audience but might need it 
later, you can hide the slide instead. Hidden slides aren’t presented in slide shows. 
They remain available from the Thumbnails pane, but their thumbnails are dimmed 
and slide numbers crossed through with a backslash.

You can edit the content of hidden slides

When you select a hidden slide, the Hide Slide button on the Slide Show tab is shaded 
to indicate that the command is in effect. You can edit a hidden slide in the Slide pane 
just as you can any other, so you might use this feature to keep a slide that you’re still 
working on hidden until it’s final. You can unhide a slide to include it in the slide show.

To hide or unhide slides

1. Select the slide or slides you want to hide or unhide.

2. Do either of the following:

 ● Right-click the selection, and then click Hide Slide.

 ● On the Slide Show tab, in the Set Up group, click the Hide Slide button.

TIP The name of the Hide Slide command and button doesn’t change; when a hidden 
slide is active, the command and button are shaded.
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To delete slides

1. Right-click a single slide, and then click Delete Slide.

Or

1. Select the slide or slides you want to delete.

2. Do any of the following:
 ● Right-click the selection, and then click Delete Slide.
 ● On the Home tab, in the Clipboard group, click Cut.
 ● Press the Delete key.

TIP When you add or delete slides in a presentation, PowerPoint renumbers all the 
subsequent slides.

Divide presentations into sections
To make it easier to organize and format a longer presentation, you can divide it into 
sections. In both Normal view and Slide Sorter view, sections are designated by titles 
above their slides. They do not appear in other views, and they do not create slides or 
otherwise interrupt the flow of the presentation.

You can rename, remove, move, collapse, and expand sections
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Because you can collapse entire sections to leave only the section titles visible, the 
sections make it easier to focus on one part of a presentation at a time.

You can collapse sections to provide an “outline” of long presentations, with the number of slides in each 
 section displayed in parentheses

TIP If you’re collaborating with other people on the development of a presentation, 
sections are a convenient way of assigning slides to different people.

Some templates include a slide layout, similar to the title slide layout, that is specifi-
cally designed for section divider slides. If you divide a long presentation into sections 
based on topic, you might want to transfer your section titles to these slides to provide 
guidance to the audience or to mark logical points in the presentation to take breaks or 
answer questions.

To create a section

1. In Normal view or Slide Sorter view, select the slide that you want to be first in 
the new section.

2. On the Home tab, in the Slides group, click the Section button, and then click 
Add Section to insert a section title named Untitled Section before the selected 
slide.

To rename a section

1. In Normal view or Slide Sorter view, do either of the following to open the 
Rename Section dialog box:

 ● Right-click the section title you want to change, and then click Rename 
Section.
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 ● On the Home tab, in the Slides group, click the Section button, and then 
click Rename Section.

The current section name is selected so that you can easily replace it

2. In the Section name box, replace or edit the existing section name, and then 
click the Rename button.

To collapse or expand one slide section

1. In Normal view or Slide Sorter view, click the arrow that precedes the section 
title.

TIP A right-pointing arrow indicates a collapsed section, an arrow that points to 
the lower-right corner indicates an expanded section.

To collapse or expand all slide sections

1. Do either of the following:

 ● On the Home tab, in the Slides group, click the Section button, and then 
click Collapse All or Expand All.

 ● Right-click any section name, and then click Expand All or Collapse All.

Rearrange slides and sections
After you have added several slides to a presentation, you might want to rearrange 
their order so that they more effectively communicate your message.

You can rearrange a presentation by moving individual slides or entire sections of 
slides.
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To move a slide within a presentation

1. In Normal view or Slide Sorter view, drag the slide thumbnail to its new posi-
tion. Notice as you drag that the other thumbnails move to indicate where the 
selected slide will appear when you release the mouse button.

Or

1. Select the slide thumbnail, and then press Ctrl+X or on the Home tab, in the 
Clipboard group, click Cut.

2. Do either of the following:

 ● Click the slide thumbnail that you want to insert the cut slide after, and then 
press Ctrl+V or, in the Clipboard group, click Paste.

 ● Click between the other slide thumbnails to insert a thin red marker (hori-
zontal in Normal view or vertical in Slide Sorter view) where you want to 
move the slide. Then press Ctrl+V or, in the Clipboard group, click Paste.

Or

1. Right-click the slide thumbnail, and then click Cut.

2. Right-click between the other slide thumbnails where you want to move the 
slide.

TIP The thin red destination marker appears only when you click between 
thumbnails, not when you right-click between thumbnails.

3. In the Paste Options section of the shortcut menu, click the Use Destination 
Theme button or the Keep Source Formatting button.

TIP When PowerPoint displays the paste options, press H to use the destination 
style or K to use the source style.

To move a section within a presentation

1. Click the title of the section of slides you want to move, to select all the slides in 
the section.

2. Drag the section to its new location.

Or
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1. Right-click the section title, and then click Move Section Up or Move Section 
Down to move the section and all its slides before the preceding section or 
after the following section.

TIP The Move Section commands aren’t available on the Section menu; they are 
available only on the shortcut menu that appears when you right-click a section title.

To merge a section into the preceding section by removing the section divider

1. Click the title of the section of slides you want to ungroup.

2. On the Home tab, in the Slides group, click the Section button, and then click 
Remove Section.

Or

1. Right-click the section title, and then click Remove Section.

To merge all sections by removing all section dividers

1. On the Home tab, in the Slides group, click the Section button, and then click 
Remove All Sections.

To delete a section of slides

1. Click the title of the section of slides you want to delete, to select all the slides in 
the section.

2. Press the Delete key.

Or

1. Right-click the section title, and then click Remove Section & Slides.

If the selected section is collapsed, PowerPoint prompts you to confirm the deletion

2. If PowerPoint prompts you to confirm the deletion, click Yes to delete the 
 section title and all the slides in the section.

TIP The Remove Section & Slides command isn’t available on the Section menu; it is 
available only on the shortcut menu that appears when you right-click a section title.
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Apply themes
The appearance of every presentation that you create is governed by a theme—a com-
bination of colors, fonts, effect styles, and background graphics or formatting that 
coordinates the appearance of all the presentation elements. Even a blank presentation 
has a theme: the Office theme, which has a white slide background, a standard set of 
text and accent colors, and the Office font set, which uses Calibri Light for headings and 
Calibri for body text.

PowerPoint and the other Office 2016 apps share a common set of themes and theme 
elements. This enables you to easily produce coordinated print and presentation 
materials. Approximately 30 of these themes are available to you from the PowerPoint 
Themes gallery. Many of the themes come with predefined variants, which have a dif-
ferent color scheme or background graphic.

The built-in Office themes for PowerPoint

Each thumbnail in the PowerPoint Themes gallery displays a sample of the font set 
in the form of an uppercase and lowercase letter A (Aa) and the color scheme in the 
form of colored blocks over the default title slide. Title slides frequently have back-
ground graphics that set the tone for the presentation. The standard slides associated 
with the theme will often have a more-subtle background graphic that coordinates 
with the title slide background. You can choose to hide the background graphic and 
use only a colored background if you want to.

You can change the theme that is applied to an entire presentation or to only one sec-
tion of the presentation. If you like the colors of one theme, the fonts of another, and 
the effects of another, you can mix and match theme elements. You can also create 
your own themes.
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SEE ALSO For information about creating themes and custom theme elements, see 
“Create custom themes” in Chapter 12, “Create custom presentation elements.”

When you’re working in Normal view you can use the Live Preview feature to see how 
your presentation would look with a different theme applied. Simply point to any 
theme and pause. PowerPoint temporarily applies the selected formatting to the slide 
in the Slide pane. This makes it easy to try different themes and theme elements until 
you find the ones you want.

To apply a standard theme to a presentation

1. Display the presentation in Normal view.

2. On the Design tab, in the Themes group, click the More button (below the 
scroll arrows) to display the menu that includes the Office theme gallery and 
any custom templates on your computer.

3. Point to thumbnails in the gallery to display the theme names in tooltips and 
preview the effect of applying the themes to your presentation.

Choose a theme that enhances the content of your presentation

4.  Click a theme thumbnail to apply that theme to the entire presentation.
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To change the color scheme of the presentation

1. On the Design tab, in the Variants group, click a variant thumbnail.

Or

1. On the Design tab, in the Variants group, click the More button (below the 
scroll arrows) to expand the Variants menu.

2. On the Variants menu, click Colors, and then click the color set you want to 
apply.

Choose from the dozens of standard color schemes

TIP Changing the color scheme, font set, or effect style of a presentation doesn’t 
change the theme that is applied to the presentation.

To change the font set of the presentation

1. On the Design tab, in the Variants group, click the More button (below the 
scroll arrows) to expand the Variants menu.

2. On the Variants menu, click Fonts, and then click the font set you want to apply.

80

Chapter 3: Create and manage slides



3

Choose from same-font or complementary-font heading/body font combinations

To change the effect style of the presentation

1. On the Design tab, in the Variants group, click the More button (below the 
scroll arrows) to expand the Variants menu.

2. On the Variants menu, click Effects, and then click the effect style you want to 
apply.

The effect style preview color coordinates with the current color scheme
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To apply a theme or theme variant to only part of a presentation

1. Create a section that contains the slides you want to have a different theme.

2. Click the section header to select the section.

3. Apply the theme or theme element.

Change slide backgrounds
The presentation theme includes a standard background. The background might be a 
color or it might include a background graphic.

A variety of thematic background graphics
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You can customize slide backgrounds by removing the background graphic and fill-
ing the slide background with a solid color, a color gradient, a texture, a pattern, or a 
picture of your choice. You make these changes in the Format Background pane.

You can control the color, texture, pattern, or picture in the background of one or all slides

Each of the options in the Format Background pane has specific settings that appear 
when you select the option.

A solid color background is a good choice for readability, but if you want to add some 
interest without a lot of distraction, you can use a color gradient in which a solid color 
gradually changes to another. PowerPoint offers several light-to-dark and dark-to-light 
gradient patterns based on the color scheme. 
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You can also create custom gradients of two, three, or more colors. Each change in 
color within a gradient is controlled by a gradient stop. For each gradient stop, you can 
specify the location and specific color (including the transparency and brightness of the 
color). A color gradient can have from 2 to 10 gradient stops.

A gradient can include up to 10 color changes
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If you want something fancier than a solid color or a color gradient, you can give the 
slide background a texture or pattern. PowerPoint comes with several built-in textures 
that you can easily apply to the background of slides. 

Choose a background that doesn’t overpower your presentation

If none of these meets your needs, you might want to use a picture of a textured sur-
face. For a dramatic effect, you can even incorporate a picture of your own, although 
these are best reserved for small areas of the slide rather than the entire background.
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If you prefer to use a simple pattern rather than a texture, you can choose from 48 
patterns and set the background and foreground color to your liking.

Click any pattern to preview it on the slide

To display the Format Background pane

1. On the Design tab, in the Customize group, click the Format Background 
button.

To close the Format Background pane

1. Do either of the following:

 ● In the upper-right corner of the pane, click the Close button (the X).

 ● To the right of the pane name, click the down arrow, and then click Close.

To apply a background change to all slides

1. In the Format Background pane, configure the slide background formatting 
you want.

2. At the bottom of the pane, click the Apply to All button.
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To remove the slide background graphic applied by a theme

1. Display the Format Background pane.

2. In the Format Background pane, select the Hide background graphics 
check box.

To apply a solid background color to one or more slides

1. In the Format Background pane, click Solid fill.

2. Click the Color button to display the color palette.

The color palette displays theme colors, standard colors, and recently used colors

SEE ALSO For information about the colors you can use, see the sidebar 
“Non-theme colors” later in this topic.

3. Click a theme color variant, a solid color, or a recent color, or click More Colors 
and select a custom color.

4. Move the Transparency slider to adjust the background color transparency, or 
set a specific transparency percentage.

SEE ALSO For information about printing slides without background colors and 
images, see “Print presentations and handouts” in Chapter 9, “Review presentations.”
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To apply a gradient background color to one or more slides

1. In the Format Background pane, click Gradient fill.

2. Click the Preset gradients button, and then click a gradient option based on 
the current color palette.

Preset color gradients offer linear and radial variants of the theme accent color

Or

1. In the Type list, click Linear, Radial, Rectangular, Path, or Shade from title.

2. In the Direction list, click the direction you want the gradient to flow.

3. If you chose the Linear type, you can specify the angle you want the gradient to 
move along. Enter the angle in the Angle box.

4. If you want to add gradient stops, do either of the following in the Gradient 
Stops area:

 ● Click the Add gradient stop button, and then reposition the marker that 
appears on the slider.

 ● Click the slider in the approximate location where you want to insert the 
gradient stop.
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You can precisely control a color by adjusting the transparency and brightness

5. If you want to remove gradient stops, do either of the following in the Gradient 
Stops area:

 ● On the slider, click the marker for the gradient stop you want to remove. 
Then click the Remove gradient stop button.

 ● Drag the gradient stop marker off of the slider.

6. In the Gradient stops area, set the color, position, transparency, and brightness 
for each color in the gradient. Note the following:

 ● You can select a color swatch or match an existing color by using the eye-
dropper tool to select a color.

 ● You can change the transparency and brightness by moving the markers on 
the sliders, by entering specific percentages, or by scrolling the dials.

To apply a textured background to one or more slides

1. In the Format Background pane, click Picture or texture fill.

2. Click the Texture button to display the texture gallery. You can select from a 
variety of textures, including fabric, marble, granite, wood grain, and Formica-
like textures in various colors.

3. In the texture gallery, click the texture you want to apply.

4. Move the Transparency slider to adjust the background color transparency, or 
set a specific transparency percentage.
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Non-theme colors
Although using themes enables you to create presentations with a color-
coordinated design, you can also use colors that aren’t part of the theme. 
Whenever you apply a color to any presentation element, you can choose 
from among these options:

 ■ Six shades of each of the 10 theme colors

 ■ Ten standard colors that are available in all Office documents, regardless 
of the theme

 ■ Non-standard colors that you’ve used recently

 ■ The Standard color palette that offers permutations of primary,  
secondary, and tertiary colors in a hexagonal color wheel

Colors from the Standard color wheel remain the same in any Office document regardless 
of the color scheme
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 ■ A custom color model on which you can select from permutations of 
primary and secondary colors or specify colors by RGB (Red, Green, 
and Blue) or HSL (Hue, Saturation, and Luminescence) values

Choose a color by clicking the rainbow, sliding the shade scale, or entering an RGB or HSL 
value

If you want to make a selected element the same color as one that is used 
elsewhere on the same slide, display the color menu, click Eyedropper, and 
then click the color you want.
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To apply a patterned background to one or more slides

1. In the Format Background pane, click Pattern fill.

2. In the Pattern palette, click one of the 48 pattern swatches.

3. Click the Foreground button, and then select the primary pattern color.

4. Click the Background button, and then select the secondary pattern color. 

TIP If you want to add a watermark, such as the word Draft or Confidential, to the 
background of your slides, you need to add the text to the background of the slide 

master. For information about slide masters, see “Customize slide masters and layouts” in Chapter 
12, “Create custom presentation elements.”

Skills review
In this chapter, you learned how to:

 ■ Add and remove slides

 ■ Divide presentations into sections

 ■ Rearrange slides and sections

 ■ Apply themes

 ■ Change slide backgrounds

92

Chapter 3: Create and manage slides



Practice tasks
The practice files for these tasks are located in the PowerPoint2016SBS\
Ch03 folder. You can save the results of the tasks in the same folder.

Add and remove slides
Open the AddRemoveSlides presentation in PowerPoint, and then perform the 
 following tasks:

1. Add two slides after the title slide. First, add a slide that has the default Title 
and Content layout. Then add a slide that has the Two Content layout.

2. Add 7 more slides, so you have a total of 10 slides. Use each slide layout at least 
once.

3. In Normal view, delete slide 3.

4. Switch to Slide Sorter view, and then delete slides 5 through 8. The presentation 
now contains five slides.

5. Add seven slides to the end of the presentation by inserting the content of the 
ImportOutline document.

6. Use the Reuse Slides feature to insert the first slide from the ReuseSlides 
presentation as slide 2 in the AddRemoveSlides presentation. Then close the 
Reuse Slides pane.

7. Insert a duplicate copy of slide 2 as slide 3.

8. Hide slide 2, and then delete slide 8.

9. Save and close the presentation.
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Divide presentations into sections
Open the CreateSections presentation in Normal view, and then perform the 
 following tasks:

1. Divide the presentation into two sections:

 ● A section that contains slides 1 through 3

 ● A section that contains slides 4 through 12

2. Change the name of the first section to Introduction.

3. Switch to Slide Sorter view, and then change the name of the second section 
to Process.

4. Collapse both sections, and then expand only the Process section.

5. Save and close the presentation.

Rearrange slides and sections
Open the RearrangeSlides presentation in Normal view, and then perform the 
 following tasks:

1. Move the first slide in the Step 1 section so that it is the third slide in the Intro-
duction section. Then delete the last slide in the Introduction section.

2. Switch to Slide Sorter view and scroll through the presentation, noticing the 
sections.

3. Collapse the sections, and then rearrange them so that the sections for steps 1 
through 7 are in order and the End section is at the end of the presentation.

4. Merge the End section into the Step 7 section.

5. Save and close the presentation.
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Apply themes
Open the ApplyThemes presentation in Normal view, and then perform the following 
tasks:

1. On slide 1, click the slide title. On the Home tab, in the Font group, notice that 
the title font is blue-gray, 44-point, Times New Roman.

2. Apply the Ion theme to the presentation. On the Home tab, in the Font group, 
notice that the title font is now white, 72-point, Century Gothic.

3. Switch to Slide Sorter view, and adjust the magnification to display all the 
slides.

4. Apply the Circuit theme to the presentation. Notice that the slide background 
is blue.

5. Apply the gray variant of the Circuit theme to the Past section of the 
presentation.

6. Apply the red variant of the Circuit theme to the Present section of the 
presentation.

7. Apply the green variant of the Circuit theme to the Future section of the 
presentation.

8. Save and close the presentation.
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Change slide backgrounds
Open the ChangeBackgrounds presentation, and then perform the following tasks:

1. Apply a gradient fill background to slide 1.

2. Change the gradient type to Rectangular and set the direction to From Top 
Left Corner.

3. Configure the gradient to have the following four gradient stops:

Stop Color Position Transparency Brightness

1 Light Green 5% 0% -10%

2 White 45% 0% 90%

3 Light Blue 75% 0% 0%

4 Purple 100% 20% 0%

4. Apply the custom gradient fill to all slides in the presentation.

5. Change the background of only slide 1 to the Water droplets texture, and set 
the Transparency of the texture to 25%.

6. Save and close the presentation.
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8Add sound 
and movement 
to slides

In this chapter
 ■ Animate text and pictures on 

slides

 ■ Customize animation effects

 ■ Add audio content to slides

 ■ Add video content to slides

 ■ Compress media to decrease 
file size

 ■ Add and manage slide 
transitions

A PowerPoint presentation might be designed to provide 
ancillary information for a live presentation, or to stand 
alone as an information source. Regardless of the method 
of delivery, a presentation has no value if it doesn’t keep 
the attention of the audience. An element that can make 
the difference between an adequate presentation and 
a great presentation is the judicious use of animated 
content, sound, and videos. By incorporating these 
dynamic effects, you can grab and keep the attention of 
your audience. You can emphasize key points, control 
the focus of the discussion, and entertain in ways that will 
make your message memorable.

With PowerPoint 2016, you have so many opportunities 
to add pizzazz to your slides that it is easy to end up with 
a presentation that looks more like an amateur experi-
ment than a professional slide show. When you first start 
adding animations, sound, and videos to your slides, it 
is best to err on the conservative side. As you gain more 
experience, you’ll learn how to mix and match effects to 
get the results you want for a particular audience.

This chapter guides you through procedures related to 
animating text and pictures on slides, customizing anima-
tion effects, adding audio and video content to slides, 
compressing media to decrease file size, and adding and 
managing slide transitions.

Practice files
For this chapter, use the practice files 
from the PowerPoint2016SBS\Ch08 
folder. For practice file download 
instructions, see the introduction.
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Animate text and pictures on slides
In the context of PowerPoint, animation refers to the movement of an element on a 
slide. When used appropriately, animated slide elements can both capture the audi-
ence’s attention and effectively convey information. You can animate any individual 
objects on a slide, including text containers, pictures, and shapes. (You can’t animate 
objects that are part of the slide background or slide master, other than as part of the 
transition between slides.)

SEE ALSO For information about the movement that occurs between slides, see “Add 
and manage slide transitions” later in this chapter. 

Thoughtfully designed animations can be very informative, particularly for audience 
members who are more receptive to visual input than to auditory input. Animations 
have the added benefit of providing a consistent message with or without a presenter 
to discuss or externally illustrate a process.

The elements of a multipart animation

You can configure four types of animations: the appearance, movement, emphasis, 
and disappearance of objects on the slide. There are multiple options within these 
four categories. The options are categorized as Basic, Subtle, Moderate, and Exciting 
(although you might have a different concept of “exciting” than the PowerPoint devel-
oper who categorized the effects). A few more animation effects are available for text 
than for other slide objects.
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Here’s a breakdown of the animation effects that are available in PowerPoint 2016:

 ■ Entrance animations An object with an animated entrance is not visible when 
the slide first appears. (It is visible during the development process, but not 
when you present the slide show.) It then appears on the slide in the manner 
specified by the entrance effect. Some entrance effects are available in the 
 Animation gallery. They’re illustrated in green, and their icons provide some 
idea of the movement associated with the effect.

Have fun experimenting with the different effects

Clicking More Entrance Effects at the bottom of the Animation menu opens a 
dialog box that displays all the available entrance animations by category to 
help you choose an appropriate effect.

The entrance animation effects available for text
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 ■ Emphasis animations These effects animate an object that is already visible 
on the slide to draw attention to it, without changing its location. The emphasis 
effects that are available in the Animation gallery are illustrated in yellow.

Effects range from subtle to bold

Clicking More Emphasis Effects at the bottom of the Animation menu opens a 
dialog box that displays all the available emphasis animations by category.

The emphasis animations available for text and images
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 ■ Motion Path animations These effects move an object along a path that you 
specify, over a period of time that you specify. A few simple motion paths are 
available from the Animation gallery, but a surprisingly large variety is avail-
able from the dialog box that opens when you click More Motion Paths at the 
bottom of the Animation menu.

The motion path animations available for text

 ■ Exit animations These effects take an existing object through a process that 
results in the object no longer being visible on the slide. The exit effects that are 
available in the Animation gallery are illustrated in red.

Choose an effect that suits the style of your presentation

Additional exit effects are available from the Change Exit Effect dialog box.
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The exit animations available for text

Animations can be very simple, or very complex. Many animations have options that you 
can configure, such as the direction, speed, size, or color. For example, when you config-
ure an entrance effect for a bulleted list, you can specify whether to have the entire list 
enter the slide at the same time, or to have only one bulleted item enter at a time. After 
you choose an effect, the applicable options are available on the Effect Options menu.

Some animations have options, and others don’t
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You can apply multiple animation effects (for example, an entrance effect and an 
emphasis effect) to a single object. As you assign animations to slide objects, numbers 
appear on the objects to specify the order of the animation effects. The numbers are 
visible only when the Animation tab is active.

Each number represents one animation

As you build an animated slide, you can add and animate individual elements, or you 
can add all the elements to the slide first, and then animate them. Regardless of the 
process you choose, position the objects on the slide as follows:

 ■ Entrance effects Position the object where you want it to end up after it enters 
the slide.

 ■ Emphasis effects Position the object where it will be before and after the 
effect.

 ■ Exit effects Position the object where it will be before it leaves the slide.

After all the elements are in place, animate them in the order you want the anima-
tions to occur. (If you’re animating multiple objects, it might be helpful to write out 
a description of the process before starting.) If you animate something out of order, 
don’t worry—you can reorder the animations from within the Animation Pane.
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Animate this
Animations can greatly enrich presentation content. However, incorporating 
a “dazzling” array of animation effects into a presentation can be distracting 
or confusing to the audience. Ensure that the time you put into creating an 
animation has value to you and to your audience members.

Consider using animations to provide subliminal information—for example, 
in a multipart presentation, use one consistent entrance effect for the part 
opener titles to draw the attention of the audience members and cue them to 
a change of subject.

An excellent use of animation is to create “build slides” that add information 
in layers and essentially culminate in a review slide. Simple examples of build 
slides include:

 ■ A bulleted list that adds one item to the list at a time. For greater 
impact, display an image related to the current list item, and replace 
the image as each new list item appears.

 ■ A pie chart that displays each chart wedge individually, and finishes 
with the complete pie. Make this even more informative by displaying a 
detailed breakdown of the chart data for each category as you display 
its chart wedge.

You could achieve these effects by creating series of separate slides, but it’s 
much simpler to animate the list or chart object.

A more difficult but often worthwhile use of slide object animation is to 
provide a visual image of a process as you describe it. You can narrate the 
animation in person or, if you’re going to distribute the presentation elec-
tronically, you can record the narration and synchronize the animations with 
the relevant wording.

To animate an object on a slide

1. Display the slide in the Slide pane, and select the object that you want to ani-
mate, or its container. (For example, if you want to animate the entrance of a 
bulleted list, select the text box that contains the bulleted list.)
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2. On the Animations tab, in the Animation group, click the More button to 
display the Animation menu and gallery.

TIP If the menu expands to cover the slide content, you can drag the handle in 
the lower-right corner of the menu to resize it.

The Animation gallery and menu
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3. Do either of the following:

 ● In the Animation gallery, click the icon that represents the animation you 
want to apply.

 ● On the Animation menu, click the More command for the type of anima-
tion you want to apply, and then in the Change Type Effect dialog box, click 
the animation you want.

PowerPoint displays a live preview of the selected animation effect and adds 
an animation number adjacent to the object. A star appears next to the slide 
thumbnail to indicate that the slide contains either an animation or a transition.

In the Thumbnails pane, the star below the slide number indicates the presence of movement on 
the slide

TIP When you apply an animation, PowerPoint automatically previews (plays) the 
animation. If this is distracting to you, you can turn off this feature by clicking the 

Preview arrow (in the Preview group on the Animations tab) and then clicking AutoPreview to 
remove the check mark that indicates the option is turned on.
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To select an applied animation

1. On the slide or in the Animation Pane, click the animation number.

To display or hide the Animation Pane

1. On the Animations tab, in the Advanced Animation group, click the Animation 
Pane button.

TIP You can expand and collapse sets of animation effects in the Animation 
Pane to help you focus on those you want to work with. 

To configure animation options

1. Apply the animation, or select a previously applied animation.

2. On the Animations tab, in the Animation group, click the Effect Options 
button. (If the button is unavailable, the animation has no configurable 
options.)

The Effect Options menu has one titled section for each option that you can 
configure.

3. On the Effect Options menu, click one option in each section.

To apply multiple animation effects to one object

1. Apply the first animation effect and configure any options.

2. Select the object (not the animation). The existing animation information is 
highlighted on the Animations tab and in the Animation Pane.

3. On the Animations tab, in the Advanced Animation group, click the Add 
Animation button. In the Add Animation gallery, click the additional animation 
you want to apply.

To copy a set of animation effects from one object to another object

1. Select the source object.

2. On the Animations tab, in the Advanced Animation group, click the Animation 
Painter button.

3. Point to the object you want to format. When a paintbrush appears to the right 
of the cursor, click the object to apply the formatting.
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TIP The Animation Painter is similar to the Format Painter. If you click the Animation 
Painter button one time, you can copy the formatting to one other object. If you 

double-click the Animation Painter button, you can copy the formatting to many other objects, 
until you click the button again or press Esc to deactivate it.

To preview animations

1. Do any of the following:

 ● To preview all animations on a slide in order, on the Animations tab, in the 
Preview group, click the Preview button.

 ● To preview a specific animation and those that follow, in the Animation 
Pane, click the first animation, and then click the Play From button.

 ● To preview one animation, select the animation on the slide and then, in the 
Animation Pane, click the Play Selected button.

To remove animation effects from slide objects

1. Do either of the following in the Animation Pane:

 ● To remove one animation, right-click the animation, and then click Remove.

 ● To remove all animations, click any animation, press Ctrl+A to select all the 
animations, and then press Delete.

Customize animation effects
Many presentations don’t require much in the way of animation, and you might find 
that transitions and ready-made animation effects will meet all your animation needs. 
However, for those occasions when you want a presentation with pizzazz, you can 
customize the animation effects.

TIP Animations can be useful for self-running presentations, where there is no 
presenter to lead the audience from one concept to another.

After you apply an animation effect, you can fine-tune its action in the following ways:

 ■ Specify the direction, shape, or sequence of the animation. (The options vary 
depending on the type of animation you apply.)

 ■ Specify what action will trigger the animation. For example, you can specify 
that clicking a different object on the slide will animate the selected object.
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 ■ As an alternative to clicking the mouse button to build animated slides, have 
PowerPoint build the slide for you.

 ■ Control the implementation speed (duration) of each animation, or delay an 
animation effect.

 ■ Change the order of the animation effects.

Entrance and exit effects cause objects to appear and disappear when you’re preview-
ing or presenting a slide. However, all the objects are visible while you’re working in 
the Slide pane. A very helpful tool when managing multiple animated objects on a 
slide is the Animation Pane. Each numbered animation on the slide has a correspond-
ing entry in the Animation Pane that provides information and options for managing 
the animations.

Manage all aspects of animations from the Animation Pane
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The color coding of the Entrance, Emphasis, and Exit effects is visible in the Animation 
Pane, and a timeline is available at the bottom of the pane. The visual indicators to 
the right of each object name represent the type, starting point, and duration of each 
animation event, as follows:

 ■ The indicator color represents the animation type (green for Entrance, yellow 
for Emphasis, blue for Motion Path, and red for Exit).

 ■ The left side of the indicator aligns with the animation starting point. If the left 
sides of two indicators align, those animations start at the same time. If the 
left side of an indicator aligns with the right side of the previous indicator, the 
animations run in order.

 ■ The width of the indicator is the animation duration as it relates to the timeline 
at the bottom of the Animation Pane.

 ■ The right side of the indicator is either triangular or square. A square indicates 
that the animation has a fixed duration; a triangular edge indicates that the 
duration is set to Auto.

Each animation is an individual event. By default, each animation starts immediately 
“on click,” meaning when you switch to the slide, click the mouse button, tap the 
screen, or press an arrow key—any action that would otherwise move to the next 
slide. You can change the animation “trigger” either to run with or after another 
event, to run it after a certain length of time, or to run it when you click a specific screen 
element or reach a bookmark in an audio or video clip. You control these settings 
either from the Advanced Animation and Timing groups on the Animations tab, or 
from the Animation Pane.

Clicking an animation in the Animation Pane selects the animation and displays an 
arrow to the right of the animation timing indicators. Clicking the arrow displays a menu 
of actions. Some of these actions are available from the Animations tab, but the effect 

258

Chapter 8: Add sound and movement to slides



8

options available from this menu are more complex than those on the Effect Options 
menu in the Animation group.

You can configure these actions from the Animation Pane to customize an animation

Clicking Effect Options on the shortcut menu provides access to an effect-specific 
dialog box where you can refine that type of animation in the following ways:

 ■ Specify whether the animation should be accompanied by a sound effect.

 ■ Dim or hide the element after the animation, or have it change to a specific 
color.

 ■ If the animation is applied to text, animate all the text at once or animate it 
word by word or letter by letter.

 ■ Repeat an animation and specify what triggers its action.

 ■ If a slide has more than one level of bullet points, animate different levels 
separately.

 ■ If an object has text, animate the object and the text together (the default) or 
separately, or animate one but not the other.
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The dialog box title is the animation type, and the options available in the dialog box 
are specific to that type of animation.

Some of the settings available through the Animation Pane Effect Options menu

To open the effect-specific dialog box for an animation

1. Do either of the following in the Animation Pane:

 ● Point to the animation, click the arrow, and then click Effect Options.

 ● Double-click the animation.

To change the order of animation effects on a slide

1. On the slide or in the Animation Pane, select the animation you want to 
reorder.

2. On the Animations tab, in the Timing group, click Move Earlier or Move Later.

Or

1. In the Animation Pane, select the animation or animations that you want to move.

2. Drag the selection to the new position in the Animation Pane. The animation 
numbers change to reflect the new positions.

TIP After reordering animations, it’s a good idea to preview the animations to ensure 
that the actions happen in a logical order.
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To set the trigger for a selected animation

TIP Many of the following settings can be configured on the Animations tab, in the 
Animation Pane, or in the effect-specific options dialog box. We’ve provided one path to 

the setting, but use the interface that you’re most comfortable with. 

1. Do any of the following in the Timing group on the Animations tab:

 ● To start the animation manually, click the Start list, and then click On Click.

 ● To start the animation based on the previous animation, click the Start list, 
and then click With Previous or After Previous.

 ● To start the animation a specific period of time after the trigger, specify the 
Delay in seconds.

Or

1. Do either of the following in the Advanced Animation group on the Anima-
tions tab:

 ● To start the animation when you click an object on the slide, click the Trigger 
button, click On Click of, and then click a trigger object on the slide.

 ● To start the animation at a specific point during the playback of an audio 
clip or video clip, in the Trigger list, click On Bookmark, and then click a 
bookmark that you’ve set in an audio or video clip.

SEE ALSO For information about setting bookmarks, see the sidebar 
“Bookmark points of interest in media clips” later in this chapter.

Or

1. In the Animation Pane, drag the colored indicator bar to the starting point 
you want.

To set the duration of a selected animation

1. Do either of the following:

 ● On the Animations tab, in the Timing group, specify the Duration in 
seconds.

 ● In the Animation Pane, drag the right side of the colored indicator bar to 
set the duration in accordance with the timeline at the bottom of the pane.
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To add a sound effect to an animation

1. In the Animation Pane, double-click the animation to open the animation-
specific effect options dialog box.

2. On the Effect tab, click the Sound list, and then click the sound effect you want 
to assign to the animation.

3. Click the speaker icon to the right of the Sound list to display the volume slider, 
and set the volume level of the sound effect.

4. Click OK to close the dialog box.

Bookmark points of interest in media clips
Bookmarks are a useful new feature for PowerPoint users who incorporate 
audio, video, and animation into presentations. You can insert bookmarks 
into audio and video clips to identify locations either that you want to be able 
to quickly get to or that you want to use as triggers for other events.

For example, you could create an animation that visually describes a process, 
and record a narration that verbally describes the process. Instead of setting 
up a series of timing points to synchronize the narration and animation, you 
could insert bookmarks at key points in the narrative audio clip that trigger 
specific segments of the animation to play.

As another example, you could embed a video on a slide, and record audio 
comments about certain parts of the video. Then you can insert bookmarks 
at those points of the video to trigger the playback of the relevant audio 
comments.

When you insert bookmarks in audio and video clips within PowerPoint, 
those bookmarks exist only in PowerPoint and don’t affect the original 
recording.
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To insert a bookmark in an audio or video clip, follow these steps:

1. Display the slide in Normal view and select the audio or video clip to 
display the Audio Tools or Video Tools tab group.

2. Play the clip by clicking the Play button on the playback toolbar or in 
the Preview group on the Playback tool tab.

3. At the point that you want to insert a bookmark, click the 
Add Bookmark button in the Bookmarks group on the 
Playback tool tab.

4. To insert additional bookmarks, repeat steps 2 and 3.

Bookmarks in audio or video clips are indicated by circles on the playback 
toolbar. Pointing to a bookmark on the toolbar displays a ScreenTip that 
includes the bookmark name. You can select a bookmark as the starting 
point for an animation, from the Trigger list on the Animations tab.

Adding a bookmark to a media clip makes it available as a trigger

If you create a bookmark but then don’t need it, you can remove it by select-
ing it and then clicking the Remove Bookmark button in the Bookmarks 
group on the Playback tool tab.
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Add audio content to slides
You can enhance presentations by adding sound to slide transitions, to animated 
content, to an individual slide, or to the presentation as a whole. For example, you 
could run a presentation that provides basic information and icebreakers during 
the time leading up to your actual presentation. You can add a pleasant royalty-free 
soundtrack that loops while the presentation plays, to avoid the discomfort of a room 
full of people who don’t want to break the silence.

If you plan to distribute a presentation electronically for people to watch on their own, 
you might want to add audio narration to an animation, or provide narration for the 
entire presentation.

SEE ALSO For information about adding sound effects to animations, see “Customize 
animation effects” earlier in this chapter; and to slide transitions, see “Add and manage 

slide transitions” later in this chapter.

You can add prerecorded audio content to a presentation, or record your own content 
directly within PowerPoint. PowerPoint supports the most common audio formats—
MP3, MP4, Windows audio (.wav) and Windows Media audio (.wma), and more special-
ized formats such as ADTS, AU, FLAC, MIDI, and MKA audio.

TIP The Insert Online Audio feature that was present in earlier versions of PowerPoint is 
not available in PowerPoint 2016. However, you can download royalty-free audio music 

and sound effects from many online sources. Some of these require that you credit the website 
as the source, so be sure to read the website fine print. When you locate an audio clip that you 
want to use, you can download it to your computer and follow the instructions in this topic to 
use it in a PowerPoint presentation.

When you add audio to a slide (rather than to an animation or transition), the audio 
icon (shaped like a speaker) and an accompanying trigger icon appear on the slide, 
and the trigger event appears in the Animation Pane.
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The trigger is created and added to the Animation Pane automatically

When the audio icon is selected, the Audio Tools tab group, which includes the 
Format and Playback tool tabs, appears on the ribbon, and audio playback controls 
appear on the slide.

The playback controls are simple but provide sufficient options

You can start audio content on a slide automatically or from the playback controls. 
The playback controls are visible only when the audio icon is selected. The icon isn’t 
obtrusive, but you can disguise or hide it if you want to.

You can change the size or angle of the audio icon by using the sizing handles or rotation handle

265

Add audio content to slides



You can customize the audio content by using commands on the Playback tool tab, 
as follows:

 ■ Edit the audio content so that only part of it plays.

 ■ Make the sound gradually increase and decrease in volume.

 ■ Adjust the volume or mute the sound.

 ■ Specify whether the audio content plays:

 ● Automatically when the slide appears.

 ● Only if you click its icon.

 ■ Make the audio object invisible while the presentation is displayed in Reading 
view or Slide Show view.

 ■ Specify that the audio content should play continuously until you stop it.

 ■ Ensure that the audio content starts from the beginning each time it is played.

To insert an audio clip onto a slide

1. Save the audio clip on your computer or on a network-connected location.

2. On the Insert tab, in the Media group, click the Audio button, and then click 
Audio on My PC to open the Insert Audio dialog box.

3. In the Insert Audio dialog box, browse to and select the audio file, and then 
click the Insert button.

Or

1. In File Explorer, open the folder that contains the audio file.

2. Arrange the File Explorer and PowerPoint windows on your screen so that both 
are visible.

3. Drag the audio file from File Explorer to the slide.

To record audio directly onto a slide

1. On the Insert tab, in the Media group, click the Audio button, and then click 
Record Audio to open the Record Sound dialog box.

2. In the Name box, enter a name to uniquely identify the recording. Then click 
the Record button (labeled with a red circle).
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The Record Sound dialog box

3. Speak or otherwise provide the audio that you want to record. When you 
finish, click the Stop button (labeled with a blue square). The audio icon and 
an accompanying trigger icon appear in the center of the slide, and the trigger 
event appears in the Animation Pane.

TIP If you record multiple clips, the audio icons stack up in the same location on 
the slide. It might be necessary to move one or more out of the way to get to an 

earlier clip.

To restrict the playback of an audio clip to a specific segment

1. Select the audio icon. On the Playback tool tab, in the Editing group, click the 
Trim Audio button to open the Trim Audio dialog box.

You can trim audio from the beginning and end of the clip, but not from the middle

2. In the Trim Audio dialog box, do any of the following:
 ● Click the Play button to play the clip, and then click the Pause button to 

pause when you locate a point that you want to mark.
 ● Drag the green Start marker to specify a playback starting point other than 

the beginning of the clip. (If you drag the marker near the point at which 
you paused the playback, the marker snaps to that location.)
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 ● Drag the red End marker to specify a playback end point other than the end 
of the clip.

 ● Select the Start or End marker, and then click the Previous Frame or Next 
Frame button to move the selected marker back or forward 0.1 seconds 
(one-tenth of a second).

3. When you finish, click OK to close the Trim Audio dialog box.

TIP Trimming the audio affects only the playback of the audio on the slide, not the 
original audio clip. You can re-trim or restore the audio clip at any time. For informa-

tion about discarding trimmed content, see “Compress media to decrease file size” later in 
this chapter. 

To fade into or out of an audio clip

1. Select the audio icon. On the Playback tool tab, in the Editing group, do the 
following:

 ● In the Fade In box, specify the length of time over which you want to 
increase the audio to full volume.

 ● In the Fade Out box, specify the number of seconds at the end of the audio 
clip over which you want to decrease the audio volume.

TIP The Fade In and Fade Out times can be specified precisely down to a 
hundredth of a second. 

To modify or hide the audio icon

1. Select the audio icon, and then do any of the following:

 ● Drag the sizing handles to make the icon larger or smaller.

 ● Drag the icon to a different location on the slide, or to a location slightly off 
the slide but still on the development canvas.

 ● Use the commands on the Format tool tab to change the icon’s appearance.

 ● Replace the default icon with a different image (such as a picture or logo).
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To manually start audio playback

1. Do any of the following:

 ● In Normal view, Reading view, or Slide Show view, point to the audio icon. 
When the playback controls appear, click the Play button.

 ● In Normal view, click the audio icon, and then click the Play button on the 
playback toolbar or in the Preview group on the Playback tool tab.

 ● In Slide Show view, after the audio icon has had focus, press Alt+P.

TIP To play sounds and other audio content, you must have a sound card and speakers 
installed.

To automatically start audio playback

1. On the Playback tool tab, in the Audio Options group, in the Start list, click 
Automatically. Then select the Loop until Stopped check box.

TIP If your presentation might be viewed by people using assistive technologies such as 
screen readers or text-to-speech tools, you should avoid starting audio clips or files 

automatically. Instead, allow the user to play the audio content after the tool has finished 
communicating the slide content.

To prevent an audio clip from stopping when the slide changes

1. On the Playback tool tab, do either of the following:

 ● To play to the end of the audio and then stop, in the Audio Options group, 
select the Play Across Slides check box.

 ● To loop the audio until the end of the slide show regardless of other audio 
tracks, in the Audio Styles group, click the Play in Background button.
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To loop (repeat) an audio clip

1. On the Playback tool tab, in the Audio Options group, select the Loop until 
Stopped check box.

TIP To automatically start and continuously play an audio clip through an entire slide 
show, configure the settings as follows: On the Playback tool tab, in the Audio Options 

group, change the Start setting to Automatically. Then select the Play Across Slides, Loop Until 
Stopped, and Hide During Show check boxes.

Add video content to slides
Sometimes the best way to ensure that your audience understands your message 
is to show a video. For example, if your company has developed a short advertising 
video, it makes more sense to include the video in a presentation about marketing 
plans than to try to describe it by using bullet points or even pictures. To save you the 
trouble of switching between PowerPoint and a video player, you can embed a video 
recording directly onto a slide, and then play the video as part of presenting the slide 
show. This is a much smoother way of presenting information from multiple sources 
than switching between them.

You can insert a video onto a slide from your computer or a connected local storage 
device, from your Facebook account, from YouTube, or from a website that provides 
an “embed code” (basically, an address that you can link to).

TIP If a publicly posted video clip has an “embed code” available, you can link to the 
online video rather than embedding it in the slide show. PowerPoint uses the embed 

code to locate and play the video. As long as the video remains available in its original location 
(and you have an active Internet connection), you will be able to access and play the video from 
the slide at any time.
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After you insert the video, you can format its representation on the slide in all the 
ways that you can other imagery. You can move and resize it, display it in a frame of 
your choice, and even adjust the brightness or color contrast.

You can resize the video frame

TIP The changes that you make to an image on a slide also affect the video playback. 
So, for example, if you change the aspect ratio of the video representation on the slide, 

imagery in the video might appear to be skewed.

When working with local videos that you embed rather than online videos that you 
link to, you can fade into and out from the video playback, and manage the content 
of the video by trimming it to play only a specific portion. You can insert bookmarks 
to use as triggers for other events (for example, you might display a list of selling 
points as each is presented in the advertising video).
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Set your start and end times to focus on the specific content you want to highlight

When you're previewing or presenting a slide show, you can play (and pause) embed-
ded audio or video, move around within the recording, and control the volume by using 
the controls that appear when the audio icon or video placeholder image is active. 
When playing back a video, you can display it at the embedded size or full screen.

Many of the processes for managing video clips are the same as those for managing 
audio clips:

 ■ Restricting the playback of a video clip to a specific segment

 ■ Fading into or out of a video clip

 ■ Manually or automatically starting video playback

 ■ Preventing a video clip from stopping when the slide changes

 ■ Looping a video clip

SEE ALSO For additional information related to the preceding processes, see “Add 
audio content to slides” earlier in this chapter.
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To insert a video clip onto a slide

1. On a slide that includes a content placeholder, click the Insert Video button in 
the content placeholder to display the Insert Video window that contains links 
to all the video sources you’ve configured Office to connect to.

You can insert video clips from a variety of sources

2. In the Insert Video window, click the source of the video that you want to 
insert, and then follow the process to insert a video from the selected source.

Or

1. On any slide, on the Insert tab, in the Media group, click the Insert Video 
button, and then do either of the following:

 ● Click Online Video to open the Insert Video window. In the Insert Video 
window, click the source of the video that you want to insert, and then 
follow the process to insert a video from the selected source.

 ● Click Video on My PC to open the Insert Video dialog box. In the Insert 
Video dialog box, browse to and select the video file, and then click the 
Insert button.
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To select an embedded video

1. Click the video image one time. Selection handles appear around the video 
image, the playback toolbar appears below it, and the Video Tools tab group 
appears on the ribbon.

To move the video image on the slide

1. Select the video, and then do either of the following:

 ● Drag the video to the new location. Smart guides might appear on the slide 
to help you align the video with other objects.

 ● Press the arrow keys to move the video by small amounts.

To resize the video image on the slide and retain its aspect ratio

1. Do either of the following:

 ● Drag any corner handle. Smart guides appear on the slide to help you align 
the video with other objects.

 ● On the Format tool tab, in the Size group, set a specific Video Height or 
Video Width, and then press Enter to change both settings.

To format the video image on the slide

1. Select the video, and then apply formatting from the Format tool tab just as 
you would for a picture.

SEE ALSO For information about formatting pictures, see “Edit and format 
pictures” in Chapter 6, “Insert and manage simple graphics.”

To configure an embedded video to play back at full screen size

1. Select the video.

2. On the Playback tool tab, in the Video Options group, select the Play Full 
Screen check box.
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To set the relative volume of a video soundtrack

1. Select the video.

2. On the Playback tool tab, in the Video Options group, click the Volume button.

3. In the Volume list, click Low, Medium, High, or Mute.

Compress media to decrease file size
Trimming an audio or video clip affects only the playback of the media on the slide, 
not the original media clip. The original media clip is stored in its entirety as part of 
the presentation, and you can re-trim or restore the media clip at any time.

You can decrease the size of a PowerPoint file that contains trimmed media clips by 
discarding the unused portions of the clips. PowerPoint 2016 offers three compression 
configurations designed to balance size and quality.

Choose the size and quality that best fits your needs

When you save and close the file after compressing the media, the trimmed portions 
of the videos are discarded and no longer available. You can reverse the compression 
operation until you save and close the file.
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Hyperlink to additional resources
Presentations often include URLs of websites that provide additional informa-
tion related to the presentation topic. When a presentation will be viewed 
electronically, the URLs can be formatted as hyperlinks so that the websites 
can be accessed directly from the presentation. Hyperlinks can also provide 
access to information that might be on a hidden slide in the presentation, or 
in a separate file.

TIP If you use Microsoft Outlook, you can also use a hyperlink to open an 
email message window so that people viewing the presentation can easily 
contact you.

Hyperlinks are most frequently in text format, but you can attach a hyperlink 
to any object—for example, an image such as a shape, logo, or picture. Clicking 
the hyperlinked object then takes you directly to the linked location. Editing 
the object does not disrupt the hyperlink; however, deleting the object also 
deletes the hyperlink.

The simplest method of creating a hyperlink is to enter a URL in a text box 
and then press the Enter key. PowerPoint automatically inserts the hyperlink 
and formats the URL so that people recognize it as a hyperlink.

If you want the same hyperlink to appear on every slide in a presentation, 
attach the hyperlink to text or an object on the presentation’s master layout. 
For information about slide masters, see “Customize slide masters and lay-
outs” in Chapter 12, “Create custom presentation elements.”
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To attach a hyperlink to an object, follow these steps:

1. Select the object that you want to hyperlink from.

2. Open the Insert Hyperlink box by doing either of the following:

 ● On the Insert tab, in the Links group, click Hyperlink.

 ● Press Ctrl+K.

3. In the Link to list, click the type of target you’re linking to. Often this is 
a webpage or another place in the file.

You can link to internal, local, and online locations

4. If you’re linking to a webpage, enter the URL in the Address box. If 
you’re linking to a slide or heading in the current file, click it in the 
Select a place in this document pane. Then click OK.
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To compress media files

1. Save the PowerPoint presentation, and then display the Info page of the Back-
stage view.

Info page of the Backstage view

2. Note the total size of the presentation, the size of the media files in the presen-
tation, and the number of files that have been trimmed.

3. On the Info page, click the Compress Media button, and then click the level of 
compression you want. In the Compress Media window, PowerPoint itemizes 
the media elements and their compression levels, and reports the total space 
savings.

Compressing media files can make a big difference in file size
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4. In the Compress Media window, click the Close button. In the Media Size And 
Performance area of the Info page, the Compress Media button is active to 
indicate that media has been compressed, and specifics about the compression 
are available.

You can undo the compression if you don’t like the results

5. Play the presentation to assess the quality, and then save the file if the quality is 
acceptable.

To reverse the compression of media files

1. On the Info page, click the Compress Media button, and then click Undo. 
 PowerPoint immediately reverts to the uncompressed files.

Add and manage slide transitions
When you deliver a presentation, you can manually specify when to display the next 
slide, or you can have PowerPoint move automatically to the next slide after a specific 
amount of time. Rather than simply replacing one slide with the next, you can use 
transitions to control the way each slide appears on the screen.

PowerPoint 2016 has 48 basic transition effects divided into three categories: Subtle, 
Exciting, and Dynamic Content. Many of these have multiple options, such as the 
direction or specific form of the content in the effect.
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PowerPoint has a wide variety of slide transition effects

As with animations, take care when using transitions to not overdo it. That being 
said, transitions can be a useful way of visually drawing the audience’s attention to 
the display of a new slide. The effects in the Subtle category are designed to make the 
incoming slide content available to the audience members with the least amount of 
movement. 

Here are some ideas about other ways to use transitions:

 ■ In a multisection presentation, use one transition on all the slides, and then use 
a different transition at the beginning of each new section of the presentation 
to signal a change in topic.

 ■ Use a more dramatic slide transition to get the audience’s attention at a specific 
point in a presentation.

You apply and manage transition effects by using the commands on the Transitions 
tab of the ribbon. The basic transition effects are available from the Transition To This 
Slide gallery. If you apply a transition that has additional options, the Effect Options 
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button becomes active and you can choose an option from the list. You can specify 
the duration of the transition effect, or add a sound effect if you want to.

Options are available for many transition effects

TIP You can add a sound effect even when the Transition is set to None. If you do, the 
sound effect plays during the normal slide replacement.

You can apply a transition effect or configure effect options for one slide at a time, for 
a group of slides, or for an entire presentation by first selecting the slide or slides you 
want to work with. (You can also apply and configure a transition effect on one slide 
and then apply that effect to all slides.) When you apply a transition effect or select an 
effect option, PowerPoint immediately demonstrates it.

As mentioned in “Animate text and pictures on slides” earlier in this chapter, PowerPoint 
displays a star next to the slide thumbnail to indicate that a slide has an animation or 
transition. (There is no indication on the slide itself.) In the Thumbnails pane or in Slide 
Sorter view, you can click the star to preview the animated slide elements beginning 
with the transition.

Every transition effect has a default duration of between 0.1 seconds and 6 seconds 
based on the complexity of the effect; most are from 1 to 2 seconds. You can change 
the duration of an effect so that the animation completes in less or more time. The 
duration is specified in seconds and can be from a minimum of .01 seconds to a maxi-
mum of 59 seconds.
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PowerPoint displays the slide timing next to the thumbnail

When you configure a transition, it affects the entrance of the slide. You can’t specifi-
cally configure an exit transition, but some of the transitions have an effect on the exit 
of the preceding slide. You can, however, configure whether the move to the next slide 
is manually initiated or happens automatically after the slide has been displayed for a 
specific length of time (which can be from 0.01 seconds to just under 24 minutes).

SEE ALSO For more information about slide timings, see “Rehearse a presentation and 
set slide timings” in Chapter 10, “Prepare and deliver presentations.”

To select slides to apply or configure transitions

1. Do either of the following:

 ● Display the presentation in Normal view, and select one or more slides in 
the Thumbnails pane.

 ● Display the presentation in Slide Sorter view, and select one or more slides 
in the Slides pane.

TIP To select multiple contiguous slides, click the first slide, hold down the Shift key, 
and then click the last slide. To select multiple noncontiguous slides, click the first slide, 

hold down the Ctrl key, and then click each additional slide.
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To apply a transition to one or more slides

1. Select the slide or slides you want to apply the transition to.

2. On the Transitions tab, in the Transition to This Slide gallery, click the transition 
effect you want to apply.

To apply a transition to all slides in a presentation

1. Select all the slides, apply the transition, and then configure the transition and 
timing options.

Or

1. Apply the transition to one slide, and then configure transition and timing 
options.

2. On the Transitions tab, in the Timing group, click the Apply To All button.

To modify a transition

1. On the Transitions tab, in the Transition to This Slide group, click the Effect 
Options button, and then click the option you want. PowerPoint previews the 
modified transition effect.

To add a sound effect to a transition

1. On the Transitions tab, in the Timing group, click the Sound arrow, and then 
click the sound you want to play. PowerPoint doesn’t automatically play the 
sound when you select it; only when you preview the transition.

TIP If you want to use a sound file of your own, click Other Sound… at the 
bottom of the Sound list. In the Add Audio dialog box that opens, browse to and 

select the audio file you want to use, and then click OK. The audio file must be in the 
.wav file format.

2. If you want the sound to repeat until another sound effect plays, select the 
sound effect and then, in the Sound list, click Loop Until Next Sound.

3. If you loop the sound effect and want it to stop when you move to the next 
slide, do either of the following on the next slide:

 ● In the Sound list, click [Stop Previous Sound].

 ● In the Sound list, click any sound effect other than the one on the preceding 
slide.
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To specify the duration of a transition

1. On the Transitions tab, in the Timing group, enter or set the duration in seconds 
in the Duration box.

To preview slide transitions

1. To preview one slide transition, do any of following:

 ● Display the slide in Normal view. On the Transitions tab, in the Preview 
group, click the Preview button.

 ● Display the slide in Normal view. In the Thumbnails pane, click the star next 
to the slide number.

 ● Display the presentation in Slide Sorter view, and then click the star next to 
the slide number.

Or

1. To preview multiple slide transitions, select the first slide that you want to 
preview, and then do either of the following:

 ● On the Slide Show tab, in the Start Slide Show group, click the From Current 
Slide button.

 ● Press Shift+F5.

2. Advance through the slide show to preview each slide transition as the slide 
appears.

Or

1. To preview all slide transitions, do any of the following to start the slide show 
from the beginning, and then advance through the slide show to preview each 
slide transition as the slide appears:

 ● On the Quick Access Toolbar, click the Start From Beginning button.

 ● On the Slide Show tab, in the Start Slide Show group, click the From 
Beginning button.

 ● Press F5.
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To remove slide transitions

1. Display or select the slides you want to remove the transitions from.

2. On the Transitions tab, in the Transition to This Slide gallery, in the Subtle 
section, click None.

Skills review
In this chapter, you learned how to:

 ■ Animate text and pictures on slides

 ■ Customize animation effects

 ■ Add audio content to slides

 ■ Add video content to slides

 ■ Compress media to decrease file size

 ■ Add and manage slide transitions
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Practice tasks
The practice files for these tasks are located in the PowerPoint2016SBS 
\Ch08 folder. You can save the results of the tasks in the same folder.

Animate text and pictures on slides
Open the AnimateSlides presentation, and then perform the following tasks:

1. On slide 1, apply the Shape entrance animation to the slide title and then to the 
subtitle. Notice that the animation numbers 1 and 2 appear to the left of the 
animated objects.

2. Display slide 2, and apply the Shape entrance animation to the left content 
placeholder. Notice that boxes containing the numbers 1 through 3 appear to 
the left of the bullet points to indicate the order of their animations.

3. Repeat task 2 for the placeholder on the right.

4. Preview all the animations on slide 2.

5. Display slide 3. Apply the Shape entrance animation to the frog photo, and 
then add the Pulse emphasis animation.

6. Copy the animations from the frog photo to the crow photo and to the cat 
photo.

7. Preview the animations on the slide, and then preview the entire presentation.

8. Return to Normal view.

9. Save and close the presentation.

Customize animation effects
Open the CustomizeAnimations presentation, and then perform the following tasks:

1. On slide 1, apply the Diamond entrance effect to the slide title. Set the direction 
to Out.

2. Copy the animation from the slide title to the subtitle. Then change the timing 
of the subtitle animation to After Previous.

3. Switch to Reading view, and preview the animation effects on slide 1.
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4. Switch back to Normal view, display slide 2, and then click anywhere in the bul-
leted list on the left.

5. Display the Animation Pane. Right-click animation 1, and then click Effect 
Options to open the Circle dialog box.

6. In the Circle dialog box, do the following:

 ● Apply the Chime sound.

 ● Dim the text color to Red after the animation.

 ● Animate the text by letter.

 ● Set the duration to 3 seconds (Slow).

7. Watch the effects of your changes to the animation effects.

The Shape animation doesn’t work very well with the selected effect options, so 
let’s adjust them.

8. On the slide, click the left content placeholder. Notice that in the Animation 
Pane, all the animations for the bullet points in the placeholder are selected.

9. Apply the Float In entrance animation to the entire placeholder, and then dis-
play the effect options.

10. In the Float Up dialog box, do the following:

 ● Apply the Chime sound.

 ● Dim the text color to Red after the animation.

 ● Animate text by letter.

 ● Set the duration to 1 seconds (Fast).

11. Preview the animations, and make any additional adjustments you want to your 
custom animation effects.

12. Copy the animation effects of the bullet points on the left to those on the right.

13. Switch to Reading view, and then click the Next button to display the animated 
bullet points on slide 2.

14. When all the bullet points are visible and dimmed to red, press the Esc key to 
return to Normal view.

15. Save and close the presentation.

287

Practice tasks



Add audio content to slides
Open the AddAudio presentation, display slide 1, and then perform the following tasks:

1. On the Insert tab, in the Media group, click the Audio button, and then click 
Audio on My PC to open the Insert Audio dialog box.

2. In the Insert Audio dialog box, browse to the practice file folder, and double-
click the SoundTrack file to insert the audio clip on the slide.

3. On the Playback tool tab, in the Audio Options group, change the Start setting 
to Automatically. Then select the Play Across Slides, Loop until Stopped, and 
Hide During Show check boxes.

4. Switch to Reading view, and listen to the audio file as the presentation moves 
from slide to slide.

5. Press Esc to stop the presentation and return to Normal view.

6. Save and close the presentation.

Add video content to slides
Open the AddVideo presentation, and then perform the following tasks:

1. In the left content placeholder, insert the Butterfly video from the practice file 
folder.

2. On the playback toolbar, click the Play/Pause button, and then watch the video.

3. Insert the Wildlife video from the practice file folder into the content place-
holder on the right, and then play the video.

4. With the Wildlife video selected, open the Trim Video dialog box, and drag 
the green start marker until it sits at about the 00:17 .020 mark. Then, frame-by-
frame, adjust the starting point until the first marmot frame comes into view at 
about the 00:17 .292 mark.

5. Drag the red stop marker until it sits at about the 00:20 .900 mark. Then, frame-
by-frame, adjust the ending point until the last marmot frame comes into view 
at about the 00:20 .790 mark.

6. Play the trimmed video, and then click OK to close the Trim Video dialog box.
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7. Change the height of the Butterfly video representation to 3”.

8. Change the height of the Wildlife video representation to 3”, and then crop it 
to a width of 4”.

9. Drag the video representations until they are evenly spaced on the slide and 
center-aligned with each other.

10. Apply the Reflected Bevel, Black (in the Intense area of the Video Styles 
gallery) video style to both video objects.

11. Set up the Butterfly video to play back on mute, to start automatically, and to 
loop until stopped.

12. Set up the Wildlife video to play back on mute, to start on click, and to loop 
until stopped.

13. Preview and pause the Butterfly video. Then preview and pause the Wildlife 
video.

14. Return to Normal view.

15. Save and close the presentation.

Compress media to decrease file size
There are no practice tasks for this topic.

Add and manage slide transitions
Open the AddTransitions presentation, and then perform the following tasks:

1. Display slide 2 in Normal view.

2. Apply the Cover transition effect (from the Subtle category) to the slide.

3. Configure the transition effect options so that the transition starts from the 
upper-left corner of the slide.

4. Apply the configured slide transition to all slides in the presentation.

5. In the Thumbnails pane, display the effect of the Cover transition from slide 2 
to slide 3.

6. Remove the transition from slide 1.
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7. Preview the slide show and notice the transitions. When you exit the slide show, 
switch to Slide Sorter view. 

8. Select all the slides that have transitions (slides 2 through 7), add the Wind 
sound effect to the transition, and then set the duration of the transition effect 
to 1 .75 seconds.

9. Preview the transition effect on one slide.

10. Save and close the presentation.
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audio content
adding narration 264
customizing 266
recording onto slides 266–267
starting 265
trimming 268

audio icons 264–265, 268
audio playback

automatically starting 269
controls 265
manually starting 269
restricting 267–268

AutoCorrect 461
configuring 126
settings 358
spelling 127

AutoFit feature 101–102
automatic spelling checking function, turning 

off 359
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placeholders 101–102
automatically running slide shows 323
available actions, keyboard shortcuts 457
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Office apps 21

removing from pictures 175–176
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styles 407
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blank presentations 29, 31
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bulleted lists
animating 250, 252
converting to diagrams 208
converting to numbered lists 120
converting to text paragraphs 120
hiding in Outline view 112
indenting list items 117
items, defined 461

business graphics
charts 218–236
diagrams 202–222

C
captions 461
capturing screen clippings 188–190
case 461
category axis 461
cell address 461
Cell Size group 155
cells (tables)

clearing fill colors 152
combining 156
customizing borders 152
definition 461
entering text 145
filling with color 150–151
moving cursor 145
removing borders 152
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style 192

Change Chart Type dialog box 222
Change File Type page 423
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app window background 23
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default PowerPoint options 352–370
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fonts, keyboard shortcuts 449
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graphics 214
keyboard focus, shortcuts 455
pen/highlighter color 342
row height 155
screen resolution 16
shapes 183
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slide magnification 343
SmartArt graphic layout 213
table size 154
table style 149
type of selected chart 222

character formatting 117
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keyboard shortcuts 449

character sets 104
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accented 104
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changing spacing 119
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formatting 117
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chart area
definition 226, 462
formatting 232
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chart element colors 235
Chart Elements pane 228–229
Chart Filters button 231
chart styles 233–234
chart titles 226
chart types

bar 218
box & whisker 219
column 218
histogram 219
line 218
pie 218, 231
sunburst 219
treemap 219
waterfall 219

charts 218–236, 462
applying chart style to 234
applying preset layouts to 229
changing size 230
changing type 222
creating 218–222
custom templates 237
displaying elements 226–230
formatting 232–236
managing data 222–225
modifying 222–230

Choose A SmartArt Graphic dialog box 204
clip art 462
Clipboard 111–112, 462

copying text to 114
cutting text to 114
pasting text from 114–115

Clipboard pane
displaying 115
displaying items in 111
display options 116
managing cut/copied items 115

Close button 9

closing
Comments pane 437
Notes pane 297
PowerPoint Options dialog box 355
presentations 51–55
Slide Master view 413

cloud storage connections 23
coauthoring presentations 438–440
collapsing outlines 112
color format, printing presentations 311
color gradient 462
Color page (Chart Styles pane) 233
color scheme

definition 462
SmartArt graphics 216

color sets 394–395
creating 397–398
deleting 399
editing 399

Colorful Office theme 22
colors

applying to presentations 80
cells (tables) 150–151
non-theme 90
shapes, changing 217–218

Colors dialog box 398
column charts 218
columns (tables)

adding 155
changing width 154
definition 462
removing 156

COM add-ins 380
combining table cells 156
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adding to Quick Access Toolbar 372–373
formatting 180
removing from a tab 377
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comments 462
adding/reviewing 435–438
deleting 438
editing 437
hiding 438
replying to 437
reviewing 437

Comments button 13
Comments group (Review tab) 435
Comments pane 435, 437
Compatibility Checker 305–306
compatibility, checking presentations 307
Compatibility Mode 55
Compound Frame, Black picture frame 

style 192
compressing media 275–277
configuring

slide transitions 281
slides for presentations 298–302
Trust Center options 383–387

Confirm Password dialog box 432
connecting

to cloud storage 23
shapes 187–188

connection points 187–188, 462
connectors 462
content

copying 65–72
displaying 46–49
finding, keyboard shortcuts 458
importing 65–72
replacing, keyboard shortcuts 458

content placeholders 140, 462
content scaling 299
content templates 29
contextual tabs 462
contiguous cells, selecting 148

copying
content 65–72
formatting from one shape to 

another 185
slides 65–72
text 115
text formats, keyboard shortcuts 450
text/objects, keyboard shortcuts 447–448

copyright symbols 103
copyrighted pictures 168
creating

charts 218–222
color sets 397
custom themes 394–402
diagrams 202–210
font sets 399
PDF/XPS files 425
slide layouts 410–411
videos 424

cropping pictures 173
currency symbols 103
cursor 462
custom color model 91
custom color sets

creating 397–398
deleting 399
editing 399

custom dictionary
adding words 129
managing 133

custom font sets, themes 399
Custom Office Templates subfolder 414
custom presentations

saving templates 413–415
slide masters and layouts 402–413
themes 394–402

Custom Shows dialog box 324
custom slide layouts 402–413
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custom slide masters 402–413
Custom Slide Show menu 322
custom slide shows 322–326, 462
custom slide sizes 300–301
custom tab groups

adding commands to 380
creating 379
renaming 379

custom tabs
creating 378
renaming 378

custom templates
charts 237
saving 413–415

custom themes 394–402
deleting 402
setting as default theme 402

Customize Colors button 397
Customize Fonts button 399
Customize Ribbon (PowerPoint Options 

page) 353, 377
customizing

cell borders 152
colors 397
fonts 399
Quick Access Toolbar 370–375
ribbon 375–380
slide shows 322–326

cutting text to Clipboard 112
cycle diagrams 203, 462

D
Dark Gray Office theme 22
data

managing chart data 222–225
tables 139–160

data labels (charts) 227

data markers (charts)
definition 226, 462
formatting 232

data points 462
data series 462
data tables

charts 227
formatting 232

default annotation colors, setting 340
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Toolbar 375
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default personal template location 415
default PowerPoint options, changing 352

advanced options 366–370
file locations 360–362
general options 353–356
language options 362–365
proofing options 356–359

default slide show view 336
default theme, setting 402
Define Custom Show dialog box 324
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custom color sets 399
custom font sets 400
custom themes 402
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text/objects, keyboard shortcuts 447–448

delivering presentations
adapting to different audiences 322–326
rehearsing and setting slide 

timings 327–331
slide shows 334–346
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Demote button 214
demoting text 101
Design tab (Slide Master view) 405
design templates 29, 32–35, 462
Design tool tab (SmartArt Tools) 212
Design tool tab (Table Tools) 146
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diagram types

cycle 203
hierarchy 203, 464
list 202
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picture 207, 465
process 202, 466
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adding shapes to 213
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creating 202–210
definition 462
formatting 215–218
modifying 212–215
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disabling

Live Preview feature 355
Mini Toolbar 355
PowerPoint Start screen 356

display languages 363

displaying
Add Chart Element menu 229
blank black/white screen 344
chart elements 226–230
Customize Ribbon (PowerPoint Options 

page) 377
Office account settings 23
pop-up toolbar 341
Quick Access Toolbar (PowerPoint Options 

page) 373
ribbon tabs 17
ScreenTips 356
separator on Quick Access Toolbar 375
Share pane 440–441
slide layouts, name and usage 411
specific page, PowerPoint Options dialog 

box 355
windows, keyboard shortcuts 452

displaying presentations
content 46–49
program elements 45–46
properties 50–51
standard views 40–45

Document Inspector 303, 463
documents See Word documents
dots (pixels) 171
double-sided pages, printing 313
dragging 463
Draw Borders group 152
drawing shapes 177–187
Dynamic Content transition effects 279

E
ebook edition xv
Edit Header & Footer link 314
Edit Theme group (Slide Master tab) 406
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editing
comments 437
custom color sets 399
custom font sets 400
embedded Excel tables 158
embedded objects, keyboard 

shortcuts 449
linked objects, keyboard shortcuts 449
photo album settings 196
pictures 172–177
presentation properties 50–51
restoring actions 116
undoing actions 116

editing languages 363, 365
editorial options 357
effect options, animation 259
effect styles 397

applying to presentations 81–82
selecting 400

effects 
See also slide transitions
applying 235
formatting charts 232
slide transitions 279–282

Effects gallery 397, 400
Email pane 427
emailing presentations 427
embed codes 270
Embed (paste option) 141
embedded objects 157–160

definition 463
editing, keyboard shortcuts 449

embedded videos 274
embedding fonts 362
Emphasis animation effects 248, 251

enabling
Live Preview feature 355
Mini Toolbar 355
PowerPoint Start screen 356

Encrypt Document dialog box 432
encrypted password protection 430
encrypting 463
ending slide shows 345
entering text

diagram shapes 209
table cells 145

Entrance animation effects 247, 251
equations

building 108
inserting 108–109
Linear form 108
Professional form 108

errata, submitting xv
error bars (charts) 227
Excel workbooks

embedding and linking content 157–160
inserting charts from 222
inserting tables from 144

Exciting transition effects 279
Exit animation effects 249–251
expanding outlines 112
Export page, Backstage view 332
exporting handouts to Word 315

F
Facebook account, connecting to Office 22
feedback, submitting xvi
File Block Settings options (Trust Center) 384
file formats 463
file locations, managing 360–362
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file name extensions 463
File Type list (Save As dialog box) 420
files, saving to OneDrive 56
fill color

applying (charts) 235
cells (tables) 150–151
clearing (tables) 152
Transparency settings 151

fills, formatting charts 232
finalizing presentations 302–309
finding

content, keyboard shortcuts 458
fonts 130
text 130

Flickr account, connecting to Office 22
flipping shapes 182
Followed Hyperlink color 394
font colors 119
font effects 463
font sets 396–398

applying to presentations 80–81
creating 399
deleting 400
editing 400

font size
definition 463
increasing 119

font styles 463
fonts 463

changing, keyboard shortcuts 449
characters 104
effects 463
embedding in a presentation 362
finding and replacing 130
resizing, keyboard shortcuts 449
sizes 463

Fonts gallery 396

footers 463
adding to printouts 314–315
adding to slides 109–110

Format Background pane 83, 86, 408
Format Data Point pane 231
Format panes (chart elements) 233, 236
Format Picture pane 302
Format tool tabs

Picture Tools 169, 172
SmartArt Tools 212

formats
graphics 171–172
saving  presentations 420–425

formatting
characters 117, 461
charts 232–236
clearing from text 120
commands 180
diagrams 215–218
notes 297
paragraphs 117–118, 121–122, 465
pictures 172–177
placeholders 410
placeholder text 410
resetting to default 107
shapes 183–186
tables 145–153
text on a shape 185
WordArt 125–126

frame styles, pictures 192
framing pictures 174–175
From A File option (Insert Pictures) 211

G
galleries

accessing, keyboard shortcuts 457
definition 463

General Options dialog box (file saving) 432
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general options, managing 353–356
General (PowerPoint Options page) 353
GIF (Graphics Interchange Format) 171
gradient slide backgrounds 83–84, 88–89
grammar-checking options 356–359
graphics 463

charts 218–236
diagrams 202–222
formats 171–172
simple graphics 167–198

Graphics Interchange Format (GIF) 171
grayscale 463
Greek letters 103
gridlines (charts) 227, 232
gridlines (slides) 47, 446
grouping

definition 463
shapes 185

groups 463
guides

displaying 47
displaying, keyboard shortcuts 446
hiding, keyboard shortcuts 446

H
handles 463

rotating 466
sizing 467

Handout Master view 464
handout masters 402, 463
handouts

exporting to Word 315
printing 309–317

header rows (tables) 140
headers, adding to printouts 314–315
heading fonts 396, 464
height, rows 155
Help language 365

Help window keyboard shortcuts 458–459
hiding

comments 438
grids/guides, keyboard shortcuts 446
ribbon 17–18
slides 72–74

hierarchy diagrams 203, 464
hierarchy of shapes, SmartArt graphics 214
highlighter color, changing 342
highlighting text 110
histogram charts 219
hyperlink color 394
hyperlinks 276–277, 464

I
icons 464
importing

content 65–71
slides 65–72

Info page (Backstage view) 306
inserting 

See also adding
charts 219
Excel charts 222
non-text content in notes 296
pictures 168–171, 169, 193, 210, 210–211
screen clippings 188–190
simple graphics 167–198
slides 64–65
SmartArt graphics 209
tables 140–145, 142

inspecting presentations 302–309
installing add-ins 382

J
Joint Photographic Experts Group (JPEG) 171
JPEG (Joint Photographic Experts Group) 171
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K
Keep Source Formatting (paste option) 141
Keep Text Only (paste option) 141
keyboard focus, changing 455
keyboard languages 363
keyboard shortcuts

definition 464
Office 2016 452–459
PowerPoint 2016 445–452

kiosk mode 464

L
language options, managing 362–365
Language (PowerPoint Options page) 353
language, setting for proofing 131
laser pointer color, setting default 340
Layout tool tab 146
layouts

charts 229
customizing slide layouts 402–413
photo albums 191

Layouts group 213
Ledger Paper (11x17 inch) slide size 299
legends (charts) 227

definition 464
formatting 232

Letter Paper (8.5x11 inch) slide size 299
line breaks

adjusting 118
definition 464
inserting 121

line charts 218
line spacing 121
Linear form, equations 108
lines (charts) 227

linked objects 157–160
definition 464
editing, keyboard shortcuts 449

LinkedIn account, connecting to Office 22
links 464
list diagrams 202
Live Preview

definition 464
enabling/disabling 355

locating formatting commands 180

M
Macro Settings options (Trust Center) 383
magnification

of screen display 15
of slides 343

managing
add-ins 380–382
advanced options 366–370
app settings 20–24
chart data 222–225
file locations 360–362
general Office and PowerPoint 

options 353–356
language options 362–365
Office 20–24
Office 365 subscription 24
Office updates 24
proofing options 356–359
simple graphics 167–198
slide layouts, title and footer display 411
slide masters, footer content 412
slide timings 331

manually running a slide show 323
Master Layout dialog box 406
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master layouts 276, 403
masters

customizing 402–413
definition 464

mathematical operators 103
mathematical symbols 108–109
matrix diagrams 203
Maximize button 9
maximizing app windows 16
media

compressing 275–277
inserting in Notes Page view 296
uncompressing 279

media shortcuts 452
menus, resizing 253
Message Bar options 384
Microsoft account options 21
Microsoft Office Clipboard 464
Microsoft Office Presentation Service 427
Microsoft PowerPoint Viewer 464
Microsoft Press contact information xv
Microsoft Press Store xv
Microsoft Press Twitter address xvi
Mini Toolbar 118

definition 464
enabling/disabling 355

Minimize button 9
modifying

AutoCorrect settings 358
charts 222–230
diagrams 212–215
shapes 177–187
table structure 153–157

Motion Path animation effects 249
Mouse mode 16

moving
between panes, keyboard shortcuts 445
buttons on Quick Access Toolbar 375
cursor from cell to cell 145
groups of shapes 186
pictures 168–171
Quick Access Toolbar 374
shapes 182
SmartArt graphic shapes 214
tables 145
text 115

multiple rows (tables), adding 155

N
narration 262, 331
navigating

presentations 39–40
ribbon, keyboard shortcuts 455

New Comment button 436
Next button (Recording toolbar) 328
nonstandard characters 103–105

inserting 105
key combinations 104

non-theme colors 90–91
Normal view 40, 464
notes, adding to slides 294–298
Notes And Handouts page 314
Notes button 13
notes master 402, 464
Notes Master view 464
Notes Page view 41, 295, 464

entering notes 298
inserting media 296

Notes pane 45–46, 295, 297, 465
numbered lists, converting to bulleted 

lists 120
numbering styles, changing 120
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O
objects 465

animating on slides 246, 252–254
applying multiple animation effects 251
applying multiple effects 255
attaching hyperlinks 276–277
copying effects 255
copying, keyboard shortcuts 447–448
deleting, keyboard shortcuts 447–448
positioning on slides 251
removing animations 256
selecting, keyboard shortcuts 446

Office 6–7, 20–24
Office 365 subscription licensing package 7
Office 2016 keyboard shortcuts 452–460
Office backgrounds 21
Office Presentation Service 428
Office themes

Colorful 22
Dark Gray 22
White 22

Offline Editing Options (PowerPoint Options 
page section) 360

on-click animations 258
OneDrive storage

connecting to Office 22
saving files to 56

online presentation, slide shows 428
On-screen Show (4:3) slide size 299
Open page (Backstage view) 36–37
opening

Chart Elements pane 229
Format pane 236
Notes pane 297
password-protected presentations 434
PowerPoint Options dialog box 24, 355
presentations 36–39
Trust Center 387

Options dialog box (save as PDF/XPS 
file) 422

outline color, applying (chart 
component) 235

Outline pane 465
demoting/promoting text 102
entering text 100

Outline view 41, 465
outlines

collapsing/expanding 112
hiding bullet points 112
keyboard shortcuts 445

outlines (charts), formatting
 232

Outlook, starting PowerPoint from 4
Overhead slide size 300

P
Package For CD

dialog box 333
feature 332, 465

packaging open presentations 332–333
palettes 465
pane access, keyboard shortcuts 457
paragraph alignment, keyboard 

shortcuts 450
paragraphs

converting bulleted list items 120
formatting 117–118, 121–122, 465
inserting line breaks 121

Password dialog box 434
password-protected presentations

opening 434
testing security 434
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passwords
definition 465
to open or modify presentations 430–435

Paste Options menu 141
pasting options 111
paths 465
patterned slide backgrounds 86–87, 92
pausing slide recordings 328
pausing timed presentations 344
PDF files, saving presentations as 420, 425
pen color

changing 342
setting default 340

Pen Color menu 152
Pen Style list 152
Pen Weight list 152
Photo Album dialog box 191
photo albums

creating 191–196
definition 465

Picture (paste option) 141
picture diagrams 207, 465
picture placeholders (SmartArt) 210
picture presentations 420, 424
Picture Tools tab group 169
pictures 465

animating 246–251
copyrights 168
editing and formatting 172–177
inserting, moving, and resizing 168–171

pie charts
animating 252
category 218
exploding 231

pixels 171, 465

placeholders 100, 465
adding to slide layouts 409
automatically fitting text 101–102
content 140
entering text 100–101
formatting 410
formatting text 410
manually adjusting sizes 119
replacing with pictures (SmartArt) 210
sizing text to fit 101

Places list 38–39
plot area (charts) 226

definition 465
formatting 232

PNG (Portable Network Graphic) 171
Pointer Options button 342
points 465
pop-up toolbar (Slide Show view) 341
Portable Network Graphic (PNG) 171
PowerPoint add-ins 380
PowerPoint Online 7, 466
PowerPoint Options dialog box 22, 352, 414

closing 355
displaying a specific page 355
opening 24, 355

PowerPoint Shows 420, 423
PowerPoint Start screen

enabling/disabling 356
using 36–37

practice files xii–xiv
preparing presentations

adapting to different audiences 322–326
rehearsing and setting slide 

timings 327–331
slide show presentation 334–346

Presentation Time counter 328
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presentations
checking spelling 131–132
coauthoring 438–440
color schemes 80
comments 435–438
configuring slides 298–302
creating 28–35
custom slide shows 322–326
effect style 81–82
font sets 80–81
inspecting and finalizing 302–309
navigating 39–40
opening 36–39
preparing for travel 332–333
presenting slide shows 334–346
printing 309–317
properties 50–51
recording 329–331
restricting access 430–435
resuming paused presentations 344
saving 51–55, 420–425
sections 73–75
setting slide timings 327–331
sharing 426–430
slide notes 294–298
slide sizes 29–30
templates 29, 31, 32–35
themes 78–83, 79
views 40–49

Presenter view 334, 466
slide notes 294
switching to Slide Show view 337

presenting slide shows online
Microsoft Office Presentation Service 428
Skype for Business 429

presenting text in tables 139–160
Preserve Fidelity (PowerPoint Options page 

section) 361

previewing
animation effects 254
animations 256
printouts 313

Print page (Backstage view) 309
printing

configuring slides for 298–302
double-sided pages 313
handouts 309–317
presentations 309–317
selecting format 313

printouts
adding headers/footers 314–315
previewing 313

Privacy Options (Trust Center) 384
procedures, adapting 18–19
process diagrams 202, 466
Professional form, equations 108
program elements, displaying 45–46
promoting

SmartArt graphic shapes 214
text 102

proofing options, managing 356–359
Proofing (PowerPoint Options page) 353
properties 466

displaying 50–51
editing 50–51

Protect Presentation button 431
Protected View options 384
pyramid diagrams 203

Q
Quick Access Toolbar 8, 466

customizing 370–375
moving 374

Quick Access Toolbar (PowerPoint Options 
page) 353

Quick Layouts (charts) 227
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R
Reading view 41, 44–45, 466
read-only

definition 466
opening presentations 434

rearranging slides and sections 75–77
Record Slide Show dialog box 330
recorded narration, testing 331
recording presentations 329–331
Recording toolbar 327
Rectangle picture frame style 192
redisplaying the ribbon 17–18
regrouping shapes 186
rehearsing presentations 327–331, 330
relationship diagrams 203, 466
releasing selections 114
removing

annotations from slide 343
backgrounds from pictures 175–176
backgrounds from slide masters 408
cell borders 152
editing languages 365
groups from ribbon tabs 377
password protection 434
rows/columns from tables 156
shapes from diagrams 213
slides 62–74, 72–74

renaming
custom tab groups 379
custom tabs 378
slide layouts 411

Repeat button (Recording toolbar) 328
replacing

content, keyboard shortcuts 458
fonts 130
pictures 210
text 130

replying to comments 437

resetting
Quick Access Toolbar 375
ribbon 380
SmartArt graphics 218

resizing
embedded Excel worksheet objects 160
fonts, keyboard shortcuts 449
Notes pane 297
pictures 168–171
shapes 182

restoring app windows 9
restoring undone editing actions 116
restricting access to presentations 430–435
reviewing comments 435–438
ribbon 9–12, 14–18

customizing 375–380
definition 466
displaying tabs 17
hiding 17–18
navigating, keyboard shortcuts 455
redisplaying 17–18
width 15

Rich Text Format (RTF) 466
rotate handle 466
rotating

shapes 182
three-dimensional chart layouts 230

Rounded Rectangle picture frame style 192
rows (tables)

adding 155
changing height 155
removing 156

running slide shows, keyboard shortcuts 450

S
Save As dialog box 361
Save Current Theme button 401
Save Current Theme dialog box 401
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Save (PowerPoint Options page) 353
Save Presentations (PowerPoint Options page 

section) 360
saving

custom presentation templates 413–415
files to OneDrive 56
presentations 51–55, 420–425

Scale Height setting 302
Scale Width setting 302
scaling

content, previewing 299
image height and width 302

screen clippings
capturing and inserting 188–190
definition 466

screen resolution 15–16
Screenshot menu 188
ScreenTips 10

definition 466
display 356

scroll bar 37–38
sections

dividing presentations into 73–75
rearranging 75–77

selecting
annotation tools 342
chart components 235
definition 466
effect styles 400
objects, keyboard shortcuts 446
pictures 170
print format 313
shapes 182
slides to print 312
tables and table elements 147–148
text 110–111, 113–114
text, keyboard shortcuts 446

selections, releasing 114
separator, Quick Access Toolbar 375
series axis 466
Set Up Show dialog box 322
Set Up Slide Show button 323
setting

custom slide sizes 301
custom theme as default theme 402
default annotation colors 340
default language setting 365
slide timings 327–331

Shading menu 150
shape colors 217
shape effects 217, 235
shape fills 217, 235
shape outlines 217
shape styles 217
shapes 466

adding to diagrams 213
changing size in diagrams 217
connecting 187–188
drawing and modifying 177–187
effects 217, 235
fills 217, 235
formatting 183–186
moving in SmartArt graphics 214
outlines 217, 235
removing from diagrams 213
Text Box margins 180

SharePoint sites, connecting to Office 22
SharePoint slide libraries 71
sharing

from Share pane 440–441
presentations 426–430
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shortcuts, keyboard
Office 2016 452–460
PowerPoint 2016 445–453

Show Comments button 437
Simple Frame, Black picture frame style 192
Simple Frame, White picture frame style 192
simple graphics 167

creating a photo album 191–196
drawing and modifying shapes 177–187
editing and formatting pictures 172–177
inserting, moving, and resizing 

pictures 168–171
screen clippings 188–190

size, charts 230
size handle 467
Skype for Business, sharing 

presentations 427
slide backgrounds

Format Background pane 83, 86
gradients 83–84, 88–89
patterns 86–87, 92
textures 85–86, 89

slide layouts
 403
adding a placeholder 409
changing background 406
creating 410–411
customizing 402–413
deleting 412
displaying name and usage 411
managing, title and footer display 411
renaming 411
scaling images 302

slide libraries 71, 467

Slide Master view 403, 467
closing 413
switching to 406

slide masters 402
applying different themes 406
changing theme elements 406
customizing 402–413
definition 467
managing footer content 412
removing background 408

Slide pane 39–40, 467
Slide Show Options button 338
Slide Show tab (Slide Master view) 405
Slide Show view 41, 43–44, 334

definition 467
managing options 345
switching to Presenter view 337

slide shows 334–346
controlling volume 272
ending presentations 345
manually running 323
media shortcuts 452
playing audio clips 272
playing video clips 272
presenting online 428
running automatically 323
running, keyboard shortcuts 450
starting 334–337
tools 337–346

Slide Size menu 299
Slide Sorter view 41, 467
Slide Time counter 328
slide timings

definition 467
managing 331
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slide transitions
See also effects
adding sound effects 283
applying to slides 283
categories 279
definition 468
duration 281
Dynamic Content effects 279
effects 280–281
entrance/exit 282
Exciting effects 279
modifying 283
previewing 284
removing 285
selecting slides 282
sound effects 281
specifying duration 284
Subtle effects 279

slides
adding 62–74
adding audio content 264–270
adding footers 109–110
adding notes 294–298
adding video content 270–275
animating objects 252
animation/transition indicator 254
audio playback controls 265
backgrounds 82–92
building with animations 251, 252
changing magnification 343
configuring for presentations 298–302
copying 65–72
creating charts 221
creating diagrams 209
deleting 72–74
hiding 72–74
importing 65–72

inserting 64–65
inserting audio clips 266
inserting video clips 273
moving through, any view 341
moving video images 274
rearranging 75–77
recording audio onto 266–267
removing 62–74
removing annotations 343
reordering animation effects 260
setting timings 327–331

smart guides 467
SmartArt graphics 467

applying shape styles 216
changing color scheme 216
changing hierarchy of shapes 214
changing layout 213
creating diagrams 202
moving shapes 214
resetting to default formatting 218

SmartArt templates 204
SmartArt Tools tab group 212
social media services, connecting to 23
Soft Edge Rectangle picture frame style 192
sound effects 281
source apps 467
source files 467
sources, add-ins 380–381
special characters 103–104, 105
spelling

changing settings 128
checking 127
checking entire presentation 131–132
correcting on slides 130
locating errors 128
proofing options 356–359
turning off spell-checking 127
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splitting table cells 156
stacks 467
standard cell borders 152
standard colors 90
Standard Colors palette 150, 397
standard paper size 301
standard screen aspect ratio 300
standard screen size presentations 30
standard themes, applying 79
standard views, displaying 40–45
Start screen

enabling/disabling 356
using 36–37

starting
custom slide shows 326
PowerPoint 4–5
slide shows 334–337
slide shows, default view 335

status bar 12–13
changing spacing 15
definition 467
specifying items 18

structure (tables) 153–157
style options (tables) 148, 149
Style page (Chart Styles pane) 233
subpoints (bulleted lists) 467
Subtle transition effects 279
sunburst charts 219
switching among views 43
switching to Slide Master view

 406
symbols 103–105

inserting 105
key combinations 104

synonyms, finding 129, 131

T
Table Size group 154
Table Style group 148
tables 139–160

definition 467
formatting 145–153
inserting 140–145
modifying structure 153–157
moving 145
moving around in, keyboard 

shortcuts 448
table style options 148
table styles, applying 149
tabs (ribbon)

creating custom tabs 378
definition 467

templates 467
charts 237
saving custom templates 413–415
SmartArt 204

testing
password protection 434
recorded narration 331

text
adding to shapes 178–179
animating 246–251
applying WordArt text effects 122–127
changing alignment 120
clearing formatting 120
copying by dragging 111
copying, keyboard shortcuts 447–448
copying to Clipboard 114–115
cutting to Clipboard 112–114
deleting 112, 117
deleting, keyboard shortcuts 447–448
demoting 101
entering in diagram shapes 209
entering in table cells 145
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text (continued)
entering on slides 100–101
finding and replacing 130
font colors 119, 394
font size 119
formatting, Notes pane 297
highlighting 110
moving 111, 115
moving around in, keyboard 

shortcuts 448
pasting from Clipboard 114–115
placeholders, formatting 410
presenting in tables 139–160
promoting 102
releasing selections 114
selecting 110–111, 113–114
selecting, keyboard shortcuts 446
supplementary, adding 106–107

Text Box margins, shapes 180
text boxes 467

formatting 107
inserting 107
setting default formatting 107
WordArt text objects 122

text case, changing 118
text effects See WordArt text effects
text formats, keyboard shortcuts 450
Text pane 205
textured slide backgrounds 85–86, 89
theme colors 150, 394, 397
theme fonts 468
themes 467

applying to presentations 78–83
color schemes 80
custom 394–402
effect style 81–82

font sets 80–81
standard 79

Thesaurus 129, 131, 468
three-dimensional chart layouts, 

rotating 230
thumbnails 11, 468
Thumbnails pane 45, 295, 468
tick-marks 468
tiling app windows 47
timed presentations, pausing/resuming 344
timing slides 327–331
Timings & Narrations list 424
title bar 8–9, 468
tool tabs 468
tools, slide shows 337–346
Touch mode 15
trademark symbols 103
transitions See slide transitions
Transparency settings (fill color) 151
traveling with presentations 332–333
treemap charts 219
trendline (charts) 227
trigger icons 264
triggering animations 258, 261
Trust Center

opening 387
options, configuring 383–387

Trust Center (PowerPoint Options page) 353, 
383

Trusted Add-in Catalogs options 383
Trusted Documents options 383
Trusted Locations options 383
Trusted Publishers options 383
turning off automatic spelling checking 359
Twitter account, connecting to Office 22
Twitter address for Microsoft Press xvi
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U
Unblack Screen button 344
undoing actions 116–117
unencrypted password protection 430
ungrouping shapes 186
Unwhite Screen button 344
Updates Available button 440
up/down bars (charts) 227
Use Destination Styles (paste option) 141
user interface 5–18

V
value axis 468
Variants gallery 397
video clips

bookmarking 262–263
embedding 271
formatting 271
inserting 270, 273
inserting trigger bookmarks 271
linking to online video 270
managing 272
sources 270

video images
formatting 274
moving on slides 274
resizing 274
retaining aspect ratios 274

video playback 271
video presentations, creating 420
video soundtracks, setting volume 275
videos

embedded 274
saving presentations as 422, 424

View Shortcuts toolbar 13, 42, 468

views
content 46–49
development 42
Handout Master 464
Normal 464
Notes Master 464
Notes Page 464
Outline 465
presentations 40–49
Presenter 466
program elements 45–46
Reading 466
Slide Master 403, 467
Slide Show 467
Slide Sorter 467
standard views 40–45
switching among 43

visual effects of shapes, changing 217–218
visual elements, simple 167–198
volume of video soundtracks 275

W
waterfall charts 219
watermarks 468
web apps 468
web browsers 468
webpages 468
websites, linking to 276
White Office theme 22
widescreen presentations 29–30
width, columns 154
window display, keyboard shortcuts 452
Windows 7, starting PowerPoint from 4
Windows 8, starting PowerPoint from 4
Windows 10, starting PowerPoint from 4

491

Windows 10, starting PowerPoint from



Word documents
exporting PowerPoint handouts to 315
inserting tables from 144

WordArt text effects 122, 468
applying to charts 235
applying to text 125, 218–219
changing object angles 126
changing object size 126
customizing 123
modifying formatting 125–126
text objects 122, 125

X
x-axis 468
XPS files, saving presentations as 420, 425

Y
y-axis 468
YouTube account, connecting to Office 22

Z
z-axis 468
Zoom button 13
Zoom Slider tool 13
Zoom tool 343
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